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cxReveal Administration Manual

The IBM Tealeaf cxImpact Administration Manual describes how to administer the
IBM Tealeaf CX system, including user administration, Portal management,
component settings, and more. Use the links below to access specific topics in the
manual.
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Chapter 1. cxReveal Administration Overview

IBM Tealeaf cxReveal packages the core IBM Tealeaf cxImpact capabilities of
session replay and search into an efficient interface for use in your enterprise?s
Call Center. Through a modified interface in the Tealeaf® Portal, IBM Tealeaf
cxReveal users can search for visitor sessions and replay them through multiple
methods. CSRs can then browse the live customer sessions with the customer on
the phone for more precise troubleshooting of customer issues, increasing customer
satisfaction and ultimately improving customer retention and generating revenue
opportunities.

Note: IBM Tealeaf cxReveal is a separately licensable component of the IBM
Tealeaf CX system. An installed version of IBM Tealeaf cxImpact is required. please
contact your IBM Tealeaf representative.

e CSR activities are surfaced through a series of provided reports and dashboards.
See “Reporting” on page 6.

This section provides an overview to IBM Tealeaf cxReveal and its components for
Tealeaf administrators.

Prerequisites

Before you begin, you should be familiar with IBM Tealeaf cxImpact and its
administration features.

* See "oxImpact Overview" in the IBM Tealeaf cxImpact User Manual.

¢ See "cxImpact Administration Manual” in the IBM Tealeaf cxImpact Administration
Manual.

For more information on IBM Tealeaf cxReveal for users, see "cxReveal User
Manual" in the IBM Tealeaf cxReveal User Manual.

How cxReveal Works

Through the Portal, IBM Tealeaf cxReveal users and administrators log in and are
provided a subset of menu options. These available options interact with the core
IBM Tealeaf cxImpact application to perform the search, replay, and reporting
actions.

The Tealeaf Portal interface allows data analysts, business owners, IT staff, and
administrative users to view the status of interactions with your website, with
aggregate data reports that display what visitors are doing on your site. Tealeaf
users can search the saved visitor sessions and analyze them for common
attributes, such as order completion. Individual visitors' sessions can be replayed
with the actual data that was sent and received, so a high-fidelity recreation of the
visitor's experience can be reviewed.

How IBM Tealeaf cxReveal users locate sessions depends on the IBM Tealeaf
cxReveal components that have been installed.

* When the core Portal components have been installed, IBM Tealeaf cxReveal
users may use the same search interface as IBM Tealeaf cxImpact users to locate
sessions.

© Copyright IBM Corp. 1999, 2014 1



— See “Portal Components.”
— See “Portal Search” on page 4.

* When the IBM Tealeaf cxReveal pipeline and database components have been
installed, IBM Tealeaf cxReveal users may use special search templates in the
Portal search interface to search the IBM Tealeaf cxReveal database for visitor
sessions.

— See “Pipeline Components” on page 3.

— See “Database Search” on page 4.

Components

2

IBM Tealeaf cxReveal provides two methods of searching for sessions:

¢ “Database Search” on page 4: On a dedicated machine, a pipeline can be
installed and configured to capture session attribute information from live
sessions and insert them into the Search database for immediate access by IBM
Tealeaf cxReveal users. Database search is the preferred method for enabling
users to access sessions. This method requires additional configuration and
installation.

Note: Tealeaf recommends using the Search database for more immediate and
more efficient searches for sessions. Searching for sessions through the Tealeaf
Canisters should be reserved for generalized searches that cannot be easily
satisfied by session attribute search.

* “Portal Search” on page 4: IBM Tealeaf cxReveal users can be permitted to use
the standard IBM Tealeaf cxImpact search templates to search for sessions.
However, Tealeaf recommends preventing IBM Tealeaf cxReveal users from
using IBM Tealeaf cxImpact templates.

— For more information on restricting access to IBM Tealeaf cxImpact search
templates and session lists, see Chapter 6, “Configuring Session Attribute
Search,” on page 51.

IBM Tealeaf cxReveal consists of the following components:
* “Pipeline Components” on page 3 (Database Search)
1. “cxReveal pipeline” on page 3

2. "Attribute Indexing Session Agent" in the IBM Tealeaf CX Configuration
Manual

3. “cxReveal database” on page 3
* “Portal Components” (Canister Search)

Portal Components

The IBM Tealeaf cxReveal components of the Portal application are installed as
part of the IBM Tealeaf cxImpact installer. These components consist of
configuration settings, search templates, and user administration capabilities for
IBM Tealeaf cxReveal that are available through the Portal.

Note: IBM Tealeaf cxReveal users may utilize the Portal components of IBM
Tealeaf cxReveal without installing the pipeline components. However, the ability
to search the IBM Tealeaf cxReveal database is not available.

* For more information on IBM Tealeaf cxReveal configuration settings, see
"cxReveal Settings" in the IBM Tealeaf cxReveal Administration Manual.

IBM Tealeaf cxReveal: cxReveal Administration Manual



* For more information on administering IBM Tealeaf cxReveal users, see
"cxReveal User Administration" in the IBM Tealeaf cxReveal Administration
Manual.

* For more information on IBM Tealeaf cxReveal search templates, see Chapter 6,
“Configuring Session Attribute Search,” on page 51.

Pipeline Components

To enable search by session attribute, IBM Tealeaf cxReveal requires a
preconfigured pipeline on a dedicated machine (the IBM Tealeaf cxReveal server)
to capture session attributes forwarded by the Tealeaf Canisters and a separate
database into which the capturing session agent inserts the session attribute
information for IBM Tealeaf cxReveal users to search.

Note: Use of the IBM Tealeaf cxReveal pipeline components requires the
installation of the Portal components first.

cxReveal pipeline

The IBM Tealeaf cxReveal pipeline is an instance of the Tealeaf Transport Service
installed on the IBM Tealeaf cxReveal server. This pipeline contains a minimum set
of session agents to capture event hits forwarded through the Event Bus from the
Tealeaf Canisters, extract session and session attribute information contained in
them, and insert or update the extracted information into the IBM Tealeaf cxReveal
database.

¢ See "Attribute Indexing Session Agent" in the IBM Tealeaf CX Configuration
Manual.

* See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis
Administration Manual.

cxReveal database

Captured session attribute information is inserted into a Tealeaf database
specifically designed to provide rapid access to this information and the related
sessions. After the first session attribute has been detected and captured in the IBM
Tealeaf cxReveal pipeline, the Attribute Indexing Session Agent creates a row
record in the current day's table in this SQL Server database containing the session
attribute information and all necessary information required to locate the session in
the source Canister in the Tealeaf environment.

* See "cxReveal Database" in the IBM Tealeaf Databases Guide.

IBM Tealeaf cxReveal manages captured session attribute information
independently of IBM Tealeaf cxImpact.

* Session attribute information is retained for 30 days in the database.

* IBM Tealeaf cxReveal expects a Session Close event to indicate that a session has
been closed in IBM Tealeaf cxImpact. See Chapter 6, “Configuring Session
Attribute Search,” on page 51.

Installation of Components

Installation is a multi-step process for each component of IBM Tealeaf cxReveal:

¢ Portal Components - Installed through the IBM Tealeaf cxImpact installer or
upgrader.

Chapter 1. cxReveal Administration Overview 3



— IBM Tealeaf cxReveal database - As part of the install or upgrade process,
you may also install the IBM Tealeaf cxReveal database.

— See "CX Installation and Setup" in the IBM Tealeaf CX Installation Manual.

* Pipeline Components - The Windows pipeline for IBM Tealeaf cxReveal is
installed through a separate installer initiated on the IBM Tealeaf cxReveal
server.

Note: Installation of the pipeline components requires a dedicated machine for
the IBM Tealeaf cxReveal pipeline and the IBM Tealeaf cxReveal database, which
requires an installed version of SQL Server. No other Tealeaf components may be
installed on this machine.

Note: Use of the pipeline components requires the Tealeaf Event Bus to send
event information to the IBM Tealeaf cxReveal server for capture. The Event Bus
is a component of IBM Tealeaf cxConnect for Data Analysis, a separately
licensable component of the IBM Tealeaf CX system. For more information,
please contact your representative.

— See "cxConnect for Data Analysis Administration Manual" in the IBM Tealeaf
cxConnect for Data Analysis Administration Manual.

1. IBM Tealeaf cxReveal database - The IBM Tealeaf cxReveal database may be
installed separately through the Tealeaf Database Manager. If you have not
done so already, you should install the database prior to installing the IBM
Tealeaf cxReveal pipeline components. See "Using Tealeaf Database Manager"
in the IBM Tealeaf Databases Guide.

2. IBM Tealeaf cxReveal pipeline - The IBM Tealeaf cxReveal pipeline is
installed and automatically configured for session attribute capture using the
IBM Tealeaf cxReveal installer.

Note: IBM Tealeaf cxReveal requires a separate license key, which may be
obtained through Tealeaf http://support.tealeaf.com.

— See Chapter 2, “cxReveal Installation,” on page 9.

Session Search

Through the Tealeaf Portal, IBM Tealeaf cxReveal users may search for visitor
sessions in either of the following methods:

* “Portal Search” - Portal search is useful for performing deep forensic searches
for matching sessions.

* “Database Search” - Database search is best utilized for locating visitor sessions
using unique and well-maintained session attributes. Additional configuration is
required.

Portal Search

IBM Tealeaf cxReveal users can use the same search templates as IBM Tealeaf
cxImpact users. However, IBM Tealeaf cxReveal users are limited to five search
fields, none of which can be All Text, Text in Request, or Text in Response.

See "cxReveal - Searching for Sessions" in the IBM Tealeaf cxReveal User Manual.

Database Search

Using a search template of IBM Tealeaf cxReveal type, IBM Tealeaf cxReveal users
may use the familiar IBM Tealeaf cxImpact search interface to query the IBM
Tealeaf cxReveal database for visitor sessions using preconfigured session attributes
as search criteria. For example, a Tealeaf administrator may define a session
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attribute to track the visitor login identifier, which can be configured to enable IBM
Tealeaf cxReveal users to search for visitor sessions using it.

Database search is much faster than Portal-based search. Sessions are available
through database search as soon as the first session attribute marked for recording
has been detected in the IBM Tealeaf cxReveal pipeline and inserted into the IBM
Tealeaf cxReveal database. Sessions are available for search from that point
forward.

* Database searches can be configured to use up to 5 session attributes that have
been marked for recording. These session attributes must be specified as search
fields in a search template of IBM Tealeaf cxReveal type. See Chapter 6,
“Configuring Session Attribute Search,” on page 51.

* By default, searching of the IBM Tealeaf cxReveal database is configured to also
query the source Canisters in the Tealeaf environment for additional session
information. However, there may be performance impacts due to these
additional queries. Optionally, you may disable the additional querying to
improve performance. See Chapter 6, “Configuring Session Attribute Search,” on
page 51.

Replay

IBM Tealeaf cxReveal users may replay sessions using either of the following
mechanisms:

* “Browser Based Replay” - Portal-based replay feature requires no additional
installation.

* “RealiTea Viewer” on page 6 - This standalone client application enables replay
from the Windows desktop. It requires a separate installation onto the desktop.

For both methods of replay, the following features are of value to IBM Tealeaf
cxReveal users:

¢ Shadow browse during live customer sessions
* Quickly search and replay any historical customer session.

* Review and insert annotations to categorize a customer's session for future
reporting and analysis.

— Users may search for annotations through the Portal and RTV interfaces.

Browser Based Replay

IBM Tealeaf cxReveal users can experience the sessions of site visitors as they
experienced them through a supported desktop browser without additional
installation. This method, called Browser-Based Replay, allows users to search and
replay through the Tealeaf Portal.

* For more information on supported, browsers, see "Logging in to the Tealeaf
Portal" in the IBM Tealeaf cxImpact User Manual.

Replay is a powerful tool for understanding the customer experience. When you
search for sessions through the Portal, you see a list of sessions matching your
search criteria. You can select one of these sessions and launch a replay of the
session.

During replay, you see the actual Web pages served to the visitor, the links the
visitor clicked on, and the form fields the visitor edited. Also available is the HTTP
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request data that was sent from the visitor's browser and the actual HTML
returned by the Web server. See "CX Browser Based Replay" in the IBM Tealeaf
cxImpact User Manual.

Browser Based Replay can be configured for IBM Tealeaf cxReveal groups and
individual users.

* For more information on configuring BBR for groups, see "cxReveal User
Administration" in the IBM Tealeaf cxReveal Administration Manual.

* Individual IBM Tealeaf cxReveal users may configure replay options within BBR.
See "BBR Options" in the IBM Tealeaf cxImpact User Manual.

RealiTea Viewer

In addition to the browser user interface for search and replay, Tealeaf also
supplies a Windows desktop application called the IBM Tealeaf CX RealiTea
Viewer (RTV) that you can install on your personal computer. This application
includes basic replay and advanced features for configuring playback on the
system. See "RealiTea Viewer (RTV) User Manual" in the IBM Tealeaf RealiTea Viewer
User Manual.

Reporting

IBM Tealeaf cxReveal administrators can be kept abreast of IBM Tealeaf cxReveal
users and overall system activity through the Tealeaf Portal.

cxReveal Users

IBM Tealeaf cxReveal user activities can be managed through a convenient
dashboard, which identifies search counts, returned results, replays and other
information by IBM Tealeaf cxReveal user or group.

* See "cxReveal Overview Dashboard” in the IBM Tealeaf cxReveal User Manual.

* Detailed reporting on Tealeaf users activities are available. See "Monitoring User
Activity" in the IBM Tealeaf cxImpact Administration Manual.

System Activity

IBM Tealeaf cxReveal administrators have access to multiple resources for
monitoring status of current sessions and system activities.

+ Current® status of active sessions in each Canister can be retrieved through the
Portal. See "Monitoring Active Status" in the IBM Tealeaf cxImpact User Manual.

* Information on the current status of the Tealeaf system can be retrieved for
individual Tealeaf components. See "System Status" in the IBM Tealeaf cxImpact
Administration Manual.

* Additional system information is available for IBM Tealeaf cxImpact
administrators. See "cxImpact Administration Manual" in the IBM Tealeaf
cxImpact Administration Manual.

cxReveal Features

For more information on the Portal features enabled with IBM Tealeaf cxReveal,
see "Portal Navigation" in the IBM Tealeaf cxImpact User Manual.

6 IBM Tealeaf cxReveal: cxReveal Administration Manual



Integration with Third-Party CRM Systems

IBM Tealeaf cxReveal supports integration with any third-party CRM through
either of the following mechanisms:

¢ IBM Tealeaf cxReveal URL API. By specifying query-based URLs, third-party
applications can retrieve IBM Tealeaf cxReveal content, including sessions for
replay, through the Portal application.

* IBM Tealeaf cxReveal Web Services API. Using the Web Services API,
developers can integrate session search and replay into a custom application.

See "cxReveal API Guide" in the IBM Tealeaf cxReveal API Guide.

Next Steps

Note: To enable database search, additional configuration is required.

For more information on installing the IBM Tealeaf cxReveal pipeline and IBM
Tealeaf cxReveal database, see Chapter 2, “cxReveal Installation,” on page 9.

* For more information on configuring the pipeline and database, see Chapter 6,
“Configuring Session Attribute Search,” on page 51.

* For more information on the IBM Tealeaf cxReveal pipeline and its session agent,

see "Attribute Indexing Session Agent" in the IBM Tealeaf CX Configuration
Manual.

* See "cxReveal Database” in the IBM Tealeaf Databases Guide.

For more information on managing IBM Tealeaf cxReveal users, their menu

profiles, and options in Browser Based Replay, see "cxReveal User Administration”

in the IBM Tealeaf cxReveal Administration Manual.

For more information on available IBM Tealeaf cxReveal settings, see "cxReveal
Settings" in the IBM Tealeaf cxReveal Administration Manual.

Chapter 1. cxReveal Administration Overview
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Chapter 2. cxReveal Installation

This section describes the requirements and steps to install IBM Tealeaf cxReveal,
its database, and its pipeline.

* For more information on upgrading, see “Upgrading cxReveal” on page 16.

Pre-Requisites

* Dedicated machine: Except in very low volume environments, IBM Tealeaf

cxReveal database and pipeline requires a dedicated machine for capturing and
storing session attributes.

— IBM Tealeaf cxReveal supports multiple deployment models. See
“Deployment Models.”

SQL Server: The IBM Tealeaf cxReveal machine requires an installation of SQL
Server for the IBM Tealeaf cxReveal database.

— Except in very low-volume environments, this installation should not be
shared with any other databases.

— Before you begin, you should install and configure SQL Server on this system.
See "Tealeaf Databases Guide" in the IBM Tealeaf Databases Guide.

Network Ports: Configure your firewall settings to allow bidirectional
communication through the following port numbers.

Note: The following table assumes that IBM Tealeaf is installed and configured
to use default port numbers. For more information about the default network
settings for IBM Tealeaf, see "Network Environment" in the Tealeaf CX Installation
Manual for more information.

Table 1. cxReveal port requirements

Port number Description

80 This port is used to communicate with the Portal Server. See "Network

Environment" in the Tealeaf CX Installation Manual for more information.

1433 This port is used to communicate with the reporting database on the

remote SQL server.

1639 This port is used by the Tealeaf Event Bus to communicate with the

canister. See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data
Analysis Administration Manual for more information.

1966 or 1967 This port is used to communicate with the pipeline. See "Network

Environment" in the Tealeaf CX Installation Manual for more information.

1971 This port is used for TCP communication.

Deployment Models

© Copyright IBM Corp. 1999, 2014

The IBM Tealeaf cxReveal pipeline and database are supported in the following
deployment models.

* “On Report Server (very low volume only)” on page 10
* “Single Dedicated cxReveal Server” on page 10
e “Multiple Dedicated cxReveal Servers” on page 10




On Report Server (very low volume only)

For web applications that average no more than 30 pages/second, you may be able
to successfully deploy the IBM Tealeaf cxReveal Server and database on the same
machine that hosts the Report Server.

Note: Before you deploy to the Report Server, review the volume of your web
application traffic and performance characteristics of the Report Server machine
with IBM Tealeaf. For more information, contact IBM Tealeaf Professional Services.

Single Dedicated cxReveal Server

For low- to medium-volume sites, the Event Bus on one or more Canisters can be
configured to feed session attribute data to a separate, dedicated server, whose sole
function is to capture session attributes in the IBM Tealeaf cxReveal pipeline and to
insert the data into the SQL Server database instance on the same machine.

Note: If you have deployed more than 3 Canisters in your Tealeaf environment,
you may overwhelm the IBM Tealeaf cxReveal Server's ability to capture and
process session attribute information. Additional IBM Tealeaf cxReveal Servers may
be required. See “Multiple Dedicated cxReveal Servers.”

Multiple Dedicated cxReveal Servers

For larger volume sites with 4 or more Canisters, you may need to deploy the IBM
Tealeaf cxReveal database across multiple dedicated IBM Tealeaf cxReveal Servers.
In this deployment model, groups of approximately 3 Canisters feed each
dedicated IBM Tealeaf cxReveal Server through the Event Bus.

* Associated with each IBM Tealeaf cxReveal Server is typically a dedicated SQL
Server instance hosting the IBM Tealeaf cxReveal database.

Additional IBM Tealeaf cxReveal Servers are installed on separate machines. The
Event Bus on the other Canisters is configured to feed these additional servers,
which have dedicated IBM Tealeaf cxReveal pipelines and IBM Tealeaf cxReveal
database instances.

* Each SQL Server database contains unique data; data is not mirrored across
instances.

Through the Portal Management page, you define each additional IBM Tealeaf
cxReveal Server, which enables the Portal to manage searches across the multiple
instances of IBM Tealeaf cxReveal database.

* See "Managing Tealeaf Servers" in the IBM Tealeaf cxImpact Administration
Manual.

cxReveal Installation

To install IBM Tealeaf cxReveal on a server, please complete the following steps.

For more information on downloading IBM Tealeaf, see IBM® Passport Advantage
Online.

1. Verify Requirements

Before you install IBM Tealeaf cxImpact or IBM Tealeaf cxReveal, you should verify
that all machines, including the IBM Tealeaf cxReveal machine, meet the minimum
system requirements.
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Note: The IBM Tealeaf cxReveal installer assumes that it is installing onto a
dedicated machine. If you are installing the Search database and IBM Tealeaf
cxReveal pipeline onto a machine that already hosts a Tealeaf pipeline, the IBM
Tealeaf cxReveal installer overwrites the existing default pipeline. Before begin
installation of IBM Tealeaf cxReveal, you should copy the current default pipeline
on the hosting machine. For more information, see "TMS Pipeline Editor" in the
IBM Tealeaf cxImpact Administration Manual.

¢ See "CX Pre-Installation Checklist" in the IBM Tealeaf CX Installation Manual.

* For more information on requirements for SQL Server, see "CX Pre-Installation
Checklist" in the IBM Tealeaf CX Installation Manual.

2. Install CX

Before you can install any IBM Tealeaf cxReveal components, you must complete
the installation of IBM Tealeaf CX.

Note: As part of your IBM Tealeaf CX installation, you must install the System
database. This database contains information that is required as part of the
installation of IBM Tealeaf cxReveal. Please retain the hostname of the server that
hosts the System database for later use during the installation of the Search
database.

For more information on installing IBM Tealeaf CX, see "CX Installation and Setup"
in the IBM Tealeaf CX Installation Manual.

Enabling the Tealeaf Canister Event Bus
After Tealeaf CX is installed and before you install cxReveal, enable the event bus
for the Tealeaf Canister. To enable the event bus:

1. From the Tealeaf Portal, select Tealeaf > TMS.
2. Select the Servers view from the pull-down list that is displayed.

3. Expand the canister component that you want to edit by clicking + next to the
canister.

4. Click Canister configuration to display the configuration information for the
canister.

5. LocateConfig Actions and click View/Edit.

6. After the Tealeaf Canister Config screen is displayed, click the Services Perform
tab.

7. Select Enable Event Bus and click Save to enable the event bus and save the
configuration to the canister.

For more information about changing the Tealeaf Canister settings, see
"Configuring the CX Canister" in the IBM Tealeaf cxReveal User Manual.

After the event bus for the Tealeaf Canister is enabled, you can continue installing
cxReveal.

3. Run cxReveal Installer on the Portal

Note: Before you run the cxReveal installer, enable the event bus for the Tealeaf
Canister. For more information about enabling the event bus, see “Enabling the
Tealeaf Canister Event Bus.”

Chapter 2. cxReveal Installation 11
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If you are installing the IBM Tealeaf cxReveal search features on a dedicated server
other than the Portal, you must enable IBM Tealeaf cxReveal within the Portal. To
enable IBM Tealeaf cxReveal, you must run the IBM Tealeaf cxReveal installer on
the Portal.

Note: When running the IBM Tealeaf cxReveal installer on the Portal in an
environment with a dedicated IBM Tealeaf cxReveal server, you must select to
enable IBM Tealeaf cxReveal only. Do not install the IBM Tealeaf cxReveal software
on the Portal server if it also resides on a different server.

Note: You may need to provide the name of the server that you have selected to
host the IBM Tealeaf cxReveal database. This database does not need to be
installed at this time.

Except in very low volume sites, installation of IBM Tealeaf cxReveal pipeline and
database on the Portal Server, which is typically the same machine as the Report
Server, is not supported.

Note: When installing the IBM Tealeaf cxReveal database on a SQL Server instance
by itself, All Databases mode is not available in the Tealeaf Database Manager. See

"Tealeaf Database Manager Reference" in the IBM Tealeaf Databases Guide.

See “Running the cxReveal Installer” on page 15 for more information.

4. Install cxReveal on the cxReveal Server

After you have installed IBM Tealeaf cxReveal on the Portal machine, you may
install on the IBM Tealeaf cxReveal machine. This process installs the dedicated
pipeline and session agent required to capture session attribute information and to
insert it into the IBM Tealeaf cxReveal database, which is installed later.

Note: If you have not done so already, the target directory for the Search database
must be created on the machine that will host it.

Note: When installing the IBM Tealeaf cxReveal database on a SQL Server instance
by itself, All Databases mode is not available in the Tealeaf Database Manager. See
"Tealeaf Database Manager Reference" in the IBM Tealeaf Databases Guide.

See “Running the cxReveal Installer” on page 15.

5. Install Search Database

If you have not done so already, you should install the IBM Tealeaf cxReveal
database through the Tealeaf Database Manager.

Note: This step is necessary only if you are installing the Search database. If you
are not installing the Search database, please skip to the next section.

1. Navigate to the following directory on the IBM Tealeaf cxReveal Server:
<Tealeaf_install_directory>\Reporting
2. Double-click TealeafDatabaseManager.exe.

3. At the Connect to Tealeaf Databases screen, enter the connection information
required to connect the Tealeaf Database Manager to the instance of SQL
Server where the Search database is to be installed.

* See "Tealeaf Database Manager Reference" in the IBM Tealeaf Databases
Guide.
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Connect to Tealeaf Databases
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Figure 1. IBM Tealeaf cxReveal Install - Connect

4.

5.

The Tealeaf Database Manager loads. From the menu, select Mode > Database
Setup > Single Database Mode.

The Tealeaf Database Manager is now configured to install individual
databases.

Before you continue, you should verify that Tealeaf Database Manager is
aware of the System database. From the Database drop-down, select System if
it is not already selected. If the database has been installed already, then the
Upgrade option for the Action on the System database should be available.

Chapter 2. cxReveal Installation 13



# Tealeaf Database Manager 8.7.0.8709 =] E3
File  Mode  SglConmection  Output Lewel DB Creation Help
Select a page Single Databaze Setup - ﬂptiuns

Ophionz
Advanced Options D atabaze

Filegroups _
Azhion I Upgrade j

Comrmand File IE:\TealeafHHepurting'\.DatahE Emwsel Spply |

Connection Info Changing the command file will revert ang changes made

Metwork: ta filegroups
Protocol: TCP/IP Cloze Connections [T
Timeout: GO0

Heportz Databazes:
Host:  wWLLIAMSO...
FPort: 1433

Yizitor Databases:
Hozt: Mot Licen...
FPort: 0

Search Databaze:
Host Mot Licen...
Faort: 0
Authentication:
Mode: “windows auth
Login: MT Account

S oo Cutput ak. E «it

Figure 2. IBM Tealeaf cxReveal Install - Single Database Mode

7. 1If the System database has been installed and IBM Tealeaf cxReveal
components have been installed on the local machine, select Search from the
Database drop-down.

8. For the Action, select Install.
9. To begin the installation, click OK.
10. When the installation completes, check the Failed Statements pane for errors.

* See "Tealeaf Database Manager Reference" in the IBM Tealeaf Databases
Guide.

* For more information on using the Tealeaf Database Manager to install
databases, see "Installing Tealeaf Databases" in the IBM Tealeaf Databases Guide.

¢ See "cxReveal Database” in the IBM Tealeaf Databases Guide.

7. Verify Operations

To test for the installation of the IBM Tealeaf cxReveal through the Portal, please
complete the following steps.

1. Login to the Portal as an administrator.
2. From the Portal menu, select Tealeaf > Portal Management.
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3. In the left navigation panel, there should be an entry for IBM Tealeaf cxReveal

Settings. If this entry is present, then IBM Tealeaf cxReveal have been
successfully installed.

* See "cxReveal Settings" in the IBM Tealeaf cxReveal Administration Manual.

If you have installed IBM Tealeaf cxReveal on a dedicated machine that is
separate from the Portal Server:

a. Click Manage Servers.
b. Verify that there is an entry for the IBM Tealeaf cxReveal Server.

* If not, create an entry for the IBM Tealeaf cxReveal Server onto which
you installed the software. See "Managing Tealeaf Servers" in the IBM
Tealeaf cxImpact Administration Manual.

Verification of the database installation and access to the database are part of
the configuration steps.

¢ See “Configuration” on page 16.

Running the cxReveal Installer

Please complete the following steps to install IBM Tealeaf cxReveal components on
a machine.

Note: If you are installing IBM Tealeaf cxReveal on a dedicated machine, run the
installer for the first time on the machine that hosts the Portal Server. Afterwards,
the installer on the dedicated IBM Tealeaf cxReveal machine.

You may skip this section if you have already installed IBM Tealeaf cxReveal.

Note: Before you run the cxReveal installer, enable the event bus for the Tealeaf
Canister. For more information about enabling the event bus, see “Enabling the
Tealeaf Canister Event Bus” on page 11.

1.

In the software distribution, navigate to the folder Enablers\cxReveal.
Double-click setup.exe to launch the installation.

Select the language that you want to use for the installation screens and click
OK.

From the Welcome screen, click Next to proceed to the License screen.

In the License screen, review the license terms and click I accept the terms;
then, click Next to continue.

From the Reveal Database Information screen, complete the following steps:

a. Enter the location where the IBM TealeafcxReveal Search database is
installed or will be installed.

b. If the database server is stored on a machine other than the local one, select
Remote Computer and enter the required settings for the remote database
server. For more information on which values to enter, please contact your
Database Administrator.

c. Click Next to continue.
From the System Database Information screen, complete the following steps:

a. Enter the location where the Tealeaf System database has been installed. For
more information on which values to enter, please contact your Database
Administrator.

b. Click Next.
From the Install screen, click Install to start the installation process.
When the Installation Complete screen appears, click Finish.
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Note: If you are installing the IBM Tealeaf cxReveal database, you must install it
separately after you have installed the software. See “5. Install Search Database” on
page 12.

Configuration

After you have installed the search database and the IBM Tealeaf cxReveal
pipeline, you must perform additional configuration within the Portal.

Configure Pipeline

As part of the installation of IBM Tealeaf cxReveal, a default pipeline is created to
capture session attribute information and insert it into the Search database. You
may need to modify this pipeline for your Tealeaf solution.

¢ See Chapter 6, “Configuring Session Attribute Search,” on page 51.

Configure cxReveal in the Portal

IBM Tealeaf cxReveal enables dedicated user and group accounts in the Portal, so
that you can manage your IBM Tealeaf cxReveal users independently. Additionally,
a separate set of configuration settings applies specifically to IBM Tealeaf cxReveal,
its users, and the Search database.

* See Chapter 3, “Initial cxReveal Configuration,” on page 19.

Upgrading cxReveal

To upgrade IBM Tealeaf cxReveal, please complete the instructions listed below for
each IBM Tealeaf cxReveal component.

* See "Upgrading Tealeaf Software on a Server" in the IBM Tealeaf CX Upgrade
Manual.

See "Same-Release Updates" in the IBM Tealeaf CX Upgrade Manual.

1. Portal components: These components are upgraded using the Upgrader on
the Portal machine.

* See "Upgrading Tealeaf Software on a Server" in the IBM Tealeaf CX Upgrade
Manual.
¢ See "Same-Release Updates" in the IBM Tealeaf CX Upgrade Manual.
2. Perform any required configuration. See “Configuration.”
3. Pipeline components: These components are upgraded using the Upgrader on
the IBM Tealeaf cxReveal machine.
* See "Upgrading Tealeaf Software on a Server" in the IBM Tealeaf CX Upgrade
Manual.
* See "Same-Release Updates" in the IBM Tealeaf CX Upgrade Manual.
4. Perform any required configuration. See “Configuration.”
5. IBM Tealeaf cxReveal database: IBM Tealeaf cxReveal utilizes a dedicated
database for storing and updating session attribute data captured through an

independent pipeline. The Search database can be upgraded through the
Tealeaf Database Manager.

* See "Upgrading the Databases to Release 8.x" in the IBM Tealeaf CX Upgrade
Manual.

* See "Using Tealeaf Database Manager" in the IBM Tealeaf Databases Guide.
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Uninstall cxReveal

Note: If you have installed IBM Tealeaf cxReveal on a server that is remote of the
Portal Server, then you must remove the server reference from the Portal
Management page. See "Managing Tealeaf Servers" in the IBM Tealeaf cxImpact
Administration Manual.

Chapter 2. cxReveal Installation 17
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Chapter 3. Initial cxReveal Configuration

Note: This section provides a framework for performing the initial configuration of
one component of the IBM Tealeaf CX system in a simplified deployment model.
Depending on your Tealeaf solution's deployment, extra configuration may be
required. If you have any questions about configuration, contact

http:/ /support.tealeaf.com.

IBM Tealeaf cxReveal enables customer call centers to take faster and better action
on customer service issues. IBM Tealeaf cxReveal packages session search and
replay from IBM Tealeaf cxImpact into a simple user interface for fast and reliable
retrieval of customer experiences with your web application.

Note: IBM Tealeaf cxReveal is a separately licensable component of the IBM
Tealeaf CX system. please contact your IBM Tealeaf representative.

This page describes how to perform the initial configuration of IBM Tealeaf
cxReveal.

e For more information on how to use IBM Tealeaf cxReveal, see "cxReveal User
Manual" in the IBM Tealeaf cxReveal User Manual.

Pre-Requisites

1. It is assumed that all Tealeaf software has been installed on Windows and
Linux servers. Before you begin, please complete all software installation first.

* See "CX Installation” in the IBM Tealeaf CX Installation Manual.
* See Chapter 2, “cxReveal Installation,” on page 9.

2. Additionally, you should have already performed the initial configuration steps
for the IBM Tealeaf cxImpact product components. See "Overview of CX
Configuration” in the IBM Tealeaf CX Configuration Manual.

3. You should determine whether you are using NT authentication to access the
Portal. If NT authentication is enabled, you can configure the automatic
creation of user accounts when authenticated domain users first contact the
Tealeaf Portal. You must configure the global auto-create settings and the
auto-create settings for the individual product to which NT users are
automatically assigned. See "Authentication" in the IBM Tealeaf cxImpact
Administration Manual.

4. The IBM Tealeaf cxReveal database is installed and configured separately. See
“Configuring cxReveal Database” on page 23.

cxReveal Settings

As part of your initial configuration, you should review the settings defined for
IBM Tealeaf cxReveal, especially if you are enabling auto-creation of user accounts
for authenticated NT users.

1. Login to the Tealeaf Portal as an administrator.

2. In the Portal menu, select Tealeaf > Portal Management.

3. In the left navigation bar, click the IBM Tealeaf cxReveal Settings link.
4

. You should review the specific settings listed below for the following
categories.
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* For more information on Search settings, see “cxReveal Search.”

* For more information on Users settings, see “cxReveal Users” on page 21.

cxReveal Search

During initial configuration, you should review the following specific settings for
IBM Tealeaf cxReveal Search:

Setting Description

BBR Annotation Options
If you are planning to enable your CSRs to add annotations to replayed
sessions, you can specify the set of available annotations here.

* For more information on annotations, see "Tracking Interactions through
BBR" in the IBM Tealeaf cxImpact User Manual.

Default Session List Template
You can specify the default session list template to be applied to all IBM
Tealeaf cxReveal users.

Display Event Info Tooltips
When enabled, event information is displayed on mouse-over in the
session list templates.

Note: This information may present a security risk. You may wish to
enable this feature with only a single IBM Tealeaf cxReveal account and
testing it before enabling it for all created IBM Tealeaf cxReveal users.

Display Passive Capture Info
When enabled, information about the IBM Tealeaf CX Passive Capture
Application and its server is displayed when IBM Tealeaf cxReveal users
drill-down into a specific page of a session.

Note: This information may present a security risk. You may wish to
enable this feature with only a single IBM Tealeaf cxReveal account and
testing it before enabling it for all created IBM Tealeaf cxReveal users.

Hit Detail Enabled
When enabled, IBM Tealeaf cxReveal users can drill into the Page Detail
page in session data.

Note: This information may present a security risk. You may wish to
enable this feature with only a single IBM Tealeaf cxReveal account and
testing it before enabling it for all created IBM Tealeaf cxReveal users.

Live Max Results Limit
The maximum number of active sessions to return from an active search.
See "CX Settings" in the IBM Tealeaf cxImpact Administration Manual.

Require At Least One Populated Search Field
When enabled, IBM Tealeaf cxReveal users must populate at least one
search field before submitting the search. This feature limits the execution
of unnecessarily large searches.

Open Browser Replay in a Featureless Window
Enables the removal of toolbars and buttons from the Browser-Based
Replay window, which will force a new window and not a new tab in the
browser.
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Require At Least One Populated Search Field
When enabled, searches executed through IBM Tealeaf cxReveal must
contain at least one populated search field to limit their scope.

Note: If you have installed the IBM Tealeaf cxReveal database, some additional
IBM Tealeaf cxReveal settings must be configured. See “Configuring cxReveal
Database” on page 23.

cxReveal Users

During initial configuration, you should review all of the settings for IBM Tealeaf
cxReveal users. See "cxReveal User Administration” in the IBM Tealeaf cxReveal
Administration Manual.

Configure Search Templates and Session List Templates

For optimal search performance, you may need to design specific search templates
to be made available to IBM Tealeaf cxReveal users. A search template defines the
fields for which a user with access to the template can access. Designing a search
template enables you to provide only the necessary search fields while removing
from access unnecessary or sensitive fields.

Additionally, you can configure session list templates. When a search is executed,
the results are displayed in the search results page, which uses a session list
template to define which fields to display. A session list template can assist CSRs
in finding the most relevant information for customer service.

Note: Templates used to search for standard session data are of IBM Tealeaf

cxImpact type. Templates used to search the IBM Tealeaf cxReveal database are of

IBM Tealeaf cxReveal type. See “Configuring cxReveal type search templates” on

page 24.

¢ For more information on configuring search templates and session list templates,
see "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

* Later in this process, you can specify search templates for individual users and
groups and default session list templates for all IBM Tealeaf cxReveal users.

These templates can then be assigned to the IBM Tealeaf cxReveal Admin and IBM
Tealeaf cxReveal User groups as needed. You may wish to assign different search
templates to each group.

 For more information on assigning users and groups, see “Configuring cxReveal
Users and Groups” below.

cxReveal User Administration

This section describes how to configure and test cxReveal user groups and
accounts.

Configuring cxReveal Users and Groups

After you have configured application settings, you can configure IBM Tealeaf
cxReveal user and group settings.

* To review the IBM Tealeaf cxReveal users who are currently logged in, click the
Current Users link in the left navigation pane of the Portal Management page.

¢ See "cxReveal User Administration” in the IBM Tealeaf cxReveal Administration
Manual.
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Note: Since IBM Tealeaf cxReveal often requires a large number of user
accounts, if auto-creation of users is enabled, you may need to periodically
review the default groups and permissions assigned to these users.

By default, IBM Tealeaf cxReveal users inherit their permissions from their primary
group. In defining permissions for IBM Tealeaf cxReveal users, you should first
assign them at the group level and then make adjustments for individual users.

When IBM Tealeaf cxReveal is installed, two user groups are automatically created,
each of which has one user:

Table 2. Configuring cxReveal Users and Groups

Group Description First User

cxReveal IBM Tealeaf cxReveal administrators | REVEALADMIN - default IBM Tealeaf
Admin cxReveal administrator account.
cxReveal IBM Tealeaf cxReveal users CSR - default IBM Tealeaf cxReveal
User user account.

Initially, these two groups have the same permissions, except for the default start
page and the admin group's ability to manage user accounts and groups.

* IBM Tealeaf cxReveal Admin users start on the Portal Management page by
default, while IBM Tealeaf cxReveal Users start on the default search template

page.
For each group, you should review the following settings at a minimum:

Setting Description

Default Password Expiration
The number of days that a password is allowed to be used before all
members of the group must choose a new one.

Password Expiration Warning Period
The number of days prior to password expiration that a user begins to
receive Portal warning messages to change it before it expires.

Default Log User Out If Idle
If set to Enable, members of this group are automatically logged out of the
Portal if their accounts are idle for a specified period of time.

* You can change the idle timeout setting. See "Configuring the Report
Server" in the IBM Tealeaf CX Configuration Manual.

Default Portal Navigation Menu
If set to Disable, members of this group cannot see the top-level Portal
navigation menu and can access only Portal pages available through their
defined default page.

Default Lock Replay Mode
If set to Disable, members of this group cannot change their Replay Mode.

Default Replay Mode
Defines the replay mode for the group. If members of this group are not
provided the IBM Tealeaf CX RealiTea Viewer application, set this value to
BBR, which is a web-based replay application.

Default Search Template
You can select the default search template to display to members of this
group from the drop-down.
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Additionally, you should review the options available by selecting each of the
following buttons at the top of the settings pane:

* Assign Users - To assign a user to the selected group, click the Assigned
checkbox and click Save.

* Menu Profile - Make selections in the menu tree to define the pages to which
members of this group can access. The default settings for IBM Tealeaf cxReveal
groups should provide adequate access.

Note: By default, the IBM Tealeaf cxReveal Admin group has additional menu
permissions to see monitoring reports, such as Activity Reports and Active
Status, which may be used to verify system status and to diagnose problems
reported by user group members.

* Administration Profile - You can select the areas of the Portal Management
page to which the group members have access.

Note: The group must have the Portal Management page in its menu profile.
Access to these areas should be reserved for administrator groups.

* Search Profile - The Search Profile defines the options available to the members
of this group on the Search page, as well as the specific search templates that
they can access.

* Browser Replay Profile - For groups with access to Browser-Based Replay, this
profile controls the actions and permissions available to group members when
using BBR.

After you have configured group-level settings, you can make adjustments to
individual user accounts. To see the user settings, click the Users link in the left
navigation pane under IBM Tealeaf cxReveal User Administration.

¢ See "cxReveal User Administration” in the IBM Tealeaf cxReveal Administration
Manual.

Test a cxReveal User Account

After you have configured user and group settings, you should create a sample
user for each group and test menu access, its default search template, and replay
features.

Review cxReveal Dashboard

IBM Tealeaf cxReveal includes a dashboard, which provides updated information
on searches and replays executed by IBM Tealeaf cxReveal users. At initial startup,
this dashboard is pre-configured to aggregate IBM Tealeaf cxReveal user search
and replay data into a convenient and well-organized dashboard.

* See "cxReveal Overview Dashboard" in the IBM Tealeaf cxReveal User Manual.

Before you allow users to access IBM Tealeaf cxReveal, you may wish to review
the configuration of this dashboard.

 See "Configuring Dashboards" in the IBM Tealeaf cxView User Manual.

Configuring cxReveal Database

The IBM Tealeaf cxReveal database can be installed and deployed to capture
session attribute information as soon as it is detected. Through this database, IBM
Tealeaf cxReveal users can access the sessions in which the attributes are contained
as soon as they are detected.
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Note: Using a separate installer, the IBM Tealeaf cxReveal database is installed on
a dedicated instance of SQL Server on a separate machine where a IBM Tealeaf
cxReveal pipeline is deployed to capture attribute information. See Chapter 2,
“cxReveal Installation,” on page 9.

Configuring Session Attribute Search

After the IBM Tealeaf cxReveal database and pipeline have been installed,
additional configuration is required. See Chapter 6, “Configuring Session Attribute
Search,” on page 51.

The above section contains references to the following important topics.

Configuring the Event Bus

To deliver session attribute information from your Tealeaf Canisters to the IBM
Tealeaf cxReveal server for processing, you must enable and configure the Tealeaf
Event Bus.

Note: The Event Bus is a component of IBM Tealeaf cxConnect for Data Analysis,
a separately licensable product. please contact your IBM Tealeaf representative.

* See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis
Administration Manual.

Configuring cxReveal type search templates
Search templates used to search the IBM Tealeaf cxReveal database require that
you use a separate type of template from IBM Tealeaf cxImpact search templates.

* See Chapter 6, “Configuring Session Attribute Search,” on page 51.

Testing Your Configuration

24

After you have completed your initial configuration, you can perform the
following steps to verify the configuration.

For IBM Tealeaf cxReveal, the key configuration item is to verify that users have
appropriate permissions to access the IBM Tealeaf cxReveal functionality required
for their role. Please complete the following steps to verify access.

* A more complete set of tests can be executed after all Tealeaf components have
been configured. See "Testing Your Tealeaf Solution" in the IBM Tealeaf CX
Configuration Manual.

1. Test REVEALADMIN account: Log in using this account.

a. Check that the account can access the appropriate menu items.

b. Verify that the account can access the IBM Tealeaf cxReveal Executive
Dashboard through the Dashboards menu. Verify that the IBM Tealeaf
cxReveal Executive Dashboard contains all of the appropriate dashboard
components.

c. Perform a search using this account. See "Searching Session Data" in the
IBM Tealeaf cxImpact User Manual.

1) Verify that the appropriate search and session list templates are
displayed. See "Configuring Search Templates" in the IBM Tealeaf
cxImpact Administration Manual.

d. Verify that you can create new IBM Tealeaf cxReveal users and groups with
this account.

1) Verify that you can retrieve results from searching.
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* Test the database-based search. See "cxReveal - Searching Sessions by
Session Attribute” in the IBM Tealeaf cxReveal User Manual.

¢ Test the Canister-based search. See "cxReveal - Searching for Sessions"
in the IBM Tealeaf cxReveal User Manual.

2. Test CSR account: Log in using this account.

a. Verify that the appropriate search and session list templates are displayed.
See "Configuring Search Templates" in the IBM Tealeaf cxImpact
Administration Manual.

b. Perform a search using this account.

* Test the database-based search. See "cxReveal - Searching Sessions by
Session Attribute" in the IBM Tealeaf cxReveal User Manual.

* Test the Canister-based search. See "cxReveal - Searching for Sessions" in
the IBM Tealeaf cxReveal User Manual.

c. Verify that you can retrieve results from searching.

When all Tealeaf components are configured, you should complete an end-to-end
test. See "Testing Your Tealeaf Solution" in the IBM Tealeaf CX Configuration Manual.

References

See “cxReveal Administration Manual” on page v.

For more information on using IBM Tealeaf cxReveal, see "cxReveal User Manual"
in the IBM Tealeaf cxReveal User Manual.

* "cxReveal - Quick Start Guide" in the IBM Tealeaf cxReveal User Manual

* "Selecting and Modifying Search Options" in the IBM Tealeaf cxReveal User
Manual

Tealeaf Event Bus

The Event Bus streams Tealeaf event data from the Short Term Canister, the
in-memory database, to a Tealeaf pipeline. The pipeline can then deliver the event
data to any system configured to receive it. The ability to send the event data as a
stream in real time makes the event bus useful for integrating with real-time
systems.

* The Event Bus runs out-of-band and does not affect the core Tealeaf processes.

Note: The Tealeaf Event Bus is a component of IBM Tealeaf cxConnect for Data
Analysis, a separately licensable component of the IBM Tealeaf CX platform. please
contact your IBM Tealeaf representative.

Complex Event Processing (CEP) engines can receive the Tealeaf event bus data as
a stream and run computations on the data to observe patterns and sequences on
the data outside of the current Tealeaf event infrastructure. The event bus data can
be correlated against other enterprise data to create new and insightful
correlations.

Note: The Tealeaf Event Bus is a high-performance pipeline and should be limited
to only session agents required to complete processing. Typically, these pipeline
configurations are limited to either of the following;:

* DecoupleEx session agent > Complex Event Processing engine
* DecoupleEx session agent > Socket session agent
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If more processing is required on the Event Bus data, it should be forwarded to
another pipeline, which by definition runs out-of-band of the Tealeaf Event Bus.

Event Bus pipeline

The default Event Bus pipeline has the following active session agents:
* DecoupleEx
* Null

The Null session agent ends delivery of event data. Nothing happens until a
proper destination is enabled in the pipeline.

* See “Testing the Event Bus” on page 30.

The configuration file is TeaLeafEventBus.cfg and is in the Tealeaf installation
directory (<Installed drive>\TeaLeaf). You can modify this file as needed to send
the event bus data to the appropriate session agent for further processing and
transmission of the data to a receiving system.

Note: The preferred method of configuring the Event Bus is through the Tealeaf
Management System.

Workflow

To deliver Tealeaf events to an external complex event processing engine, complete
the following steps:

Steps:

1. Verify installation of the required components. See “Installation.”
Enable the pipeline. See “Enabling the Event Bus” on page 27.
Configure the pipeline. See “Configuring Event bus” on page 27.
Test the pipeline locally. See “Testing the Event Bus” on page 30.

o k0N

If the Event Bus pipeline is working properly, you may terminate the pipeline
with the appropriate session agent and location.

* For more information about integrating the Event Bus with Coral8 Server, see
“Coral8 Server” on page 35.

Installation

The Tealeaf Event Bus is a separately configurable component of IBM Tealeaf
cxConnect for Data Analysis.

To install the Tealeaf Event Bus:
1. In your Tealeaf software distribution, navigate to the following directory:
cxConnect\Event Bus

2. Copy all files in this directory to the Tealeaf installation directory on the server
where IBM Tealeaf cxConnect for Data Analysis is installed. These files include
the following:

e CEPCustomFields.cfg - configuration file for custom Event Bus fields. See
“Tealeaf Event Bus” on page 25.

* Tealeaf.Pipeline.CEP.d11 - core Event Bus processing
* Tealeaf EventBus.doc - documentation for Event Bus
¢ TealeafEventBus.cfg - configuration file for core Event Bus
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If any of these fields is missing from the Tealeaf installation directory where IBM
Tealeaf cxConnect for Data Analysis was installed, check the software distribution.
For more information, contact Tealeaf http://support.tealeaf.com.

Enabling the Event Bus

To enable the pipeline, edit the Canister configuration using TMS:

Log in to the Portal as an admin user.

From the Portal menu, select Tealeaf > TMS.

In the Servers view, select the wanted server to drill down to components.
Open the Canister node to display the configurations.

Click the Canister configuration.

In the Config Actions pane, click View/Edit.

In the Services Perform tab, select the Enable Event Bus check box.

Click Save.

The Canister automatically recognizes the change in configuration and creates
the Event Bus pipeline.

© O NN~

* For more information about using TMS, see "Tealeaf Management System" in
the IBM Tealeaf cxImpact Administration Manual.

View current status of the Event Bus pipeline: After you enabled the Event Bus,
you can review the current status of the Event Bus pipeline to verify that hits are
being delivered to it.

To view the current status of the Event Bus pipeline, use the Tealeaf Capture Status
utility on the host server or the Pipeline Status tab in TMS.

See "TMS Pipeline Status Tab" in the IBM Tealeaf cxImpact Administration Manual

See "TeaLeaf Capture Status - Pipeline Monitoring Utility" in the IBM Tealeaf CX
Configuration Manual.

Configuring Event bus
You can edit details of the Event bus configuration by using the Pipeline Editor.

1. In TMS, open the Canister node to display the configurations.
2. Click Event bus configuration.

3. In the Config Actions pane, click View/Edit.

4.

The Event Bus configuration is displayed in the Pipeline Editor. For more
information about the Pipeline Editor, see "Tealeaf Management System" in the
IBM Tealeaf cxImpact Administration Manual.
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5. In the left pane, select the topmost node: Event Bus configuration. Then, click
Edit.

6. The Event Bus configuration is displayed:
Setting Description

Application Name
For the Event Bus, set this value to TealLeafEventBus.

VM Free Disable Threshold
The threshold percentage of free virtual memory below which the
pipeline automatically shuts down. To disable this check, set this value
to 0.

VM Free Enable Threshold
After a shutdown, the pipeline restarts when the percentage of free
virtual memory exceeds this value. This value should be greater than

the value set for VM Free Disable Threshold, even if that value is set to
0.

Restart Interval
The interval in seconds at which the pipeline checks to see if a restart is
necessary.

Restart Reset Interval
The period in seconds over which the pipeline can attempt restarts.

Changing timestamps:

If necessary, you can change the timestamp format that is recorded for requests in
the events sent to the Event Bus, by using the Tealeaf Portal.

By default, time values in the request are written into the [timestamp] section of
the request in a familiar format. For example:

[timestamp]
RequestTimeEx=2011-06-28T04:20:35.074529Z
RequestEndTimeEx=2011-06-28T04:20:35.074529Z
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If needed, you can change the timestamp format that is recorded for requests in
the events sent to the Event Bus to use UNIX ticks.

Note: This timestamp format change applies only to HTTP output for CEP.

Note: The change applies only to the RequestTimeEx timestamp in the hit request,
if it is included in the [HTTPFields] section in the CustomFields.cfg file. See
“Tealeaf Event Bus” on page 25.

Complete the following steps to enable this configuration change.

* The [CEP] section of the request has a DateTime name-value pair that is in
seconds since 1970 format at a resolution of one second. This event timing entry
is not affected by this configuration change.

Note: This change must be applied to each Canister sending events to the Event
Bus.

1. Log in to the Portal.
2. From the Portal menu, select Tealeaf > TMS.

3. Click the WorldView tab.
4. From the View drop-down, select Servers.
5. For each server that hosts a Canister:

a. Select the server.

Click the Canister node.

Click Event Bus configuration.
Click View/Edit Raw.

Search the configuration for "[CEP]". This section contains the raw version
of the configuration for the Event Bus on the selected Canister.

Search the [CEP] section for HTTP_PageTimeFormat.
If the entry does not exist, add the following:

®aouo

« -

HTTP_PageTimeFormat=unix

* If the entry is not present, the default Tealeaf time formatting is applied.
To switch back to the default, either delete or comment out the line. Or,
you can change the unix value to tealeaf.

h. Click Save.
i. Add the job to a task. Do not submit.
6. Repeat the above steps to the other Canisters hosting the Event Bus.

7. Submit the task to make the change at the same time for all Event Bus
instances.

8. If you did not do so already, insert the RequestTimeEx field in the [HTTPFields]
section in the CustomFields.cfg file. See “Tealeaf Event Bus” on page 25.

Sending events to the Event Bus

In order for event data to be delivered to the event bus, you must select the Send
to Event Bus check box in the More Options Step of the event definition in the
Tealeaf Event Manager. This check box must be selected for each event that you
want to send to the Event Bus.

* See "TEM Events Tab" in the IBM Tealeaf Event Manager Manual.

* See "Tealeaf Event Manager" in the IBM Tealeaf Event Manager Manual.

Chapter 3. Initial cxReveal Configuration 29



Testing the Event Bus

To test, you can direct the Event Bus to deliver .TLA files to an archive directory.

1.

11.
12.
13.

14.

15.

16.
17.

18.

19.
20.

21.

In TMS, open the Canister node to display the configurations.

2. Click Event bus configuration.
3.
4

. The Event Bus configuration is displayed in the Pipeline Editor. For more

In the Config Actions pane, click View/Edit.

information about the Pipeline Editor, see "Tealeaf Management System" in the
IBM Tealeaf cxImpact Administration Manual.

In the left pane, review the session agents in the Event Bus pipeline. In the
default configuration, the terminating session agent is the Null session agent.
The terminating session agent defines where pipeline data is delivered after
processing by the pipeline. In this case, it is not delivered.

From the Available Session Agents pane on the right side of the screen, click
and drag the Archive session agent into the pipeline. Drop it just in front of
the Null session agent.

Drag the Null session agent back to the Available Session Agents pane.
The Event Bus pipeline is now terminated at the Archive session agent.
Select the Archive session agent and click Edit.

Review the settings.

* In particular, verify the setting for Archive Directory, which identifies the
folder in which the .TLA files are delivered from the Event Bus pipeline.
This directory is typically the following:

C:\TeaLeaf\Archives
Click OK.
In the Pipeline Editor, click Save.

In the Update Servers dialog, accept all options and click Add Tasks and
Submit.

The job is submitted to TMS for immediate processing. The job includes a
restart of the affected Canister(s).

* You can monitor the progress of the job in the Jobs tab. See "TMS Jobs Tab"
in the IBM Tealeaf cxImpact Administration Manual.

When the job is completed, sessions containing Event Bus data are delivered
in Tealeaf archives to the designated directory. Check the directory for the
presence of these files.

Select one .TLA file and open it in RTV.
Open one of the enclosed sessions.

Note: If you did not include the response in the data sent to the Event Bus,
replay view does not display properly.

In the RTV toolbar, click the Request button. The request of the first page is
displayed.
Scroll down the request view until you see the [CEP] section.

If the data is present, then the Event Bus is working properly. See “Event Bus
data” on page 31.

You may now configure the Event Bus to deliver hits to the appropriate
destination.

Disabling the Event Bus
The Event Bus does not run in the same process space as the Tealeaf Transport
Service.
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Note: When the Canister Services are shut down for the selected Processing Server,
the Event Bus pipeline is ended.

Event Bus data

The Event Bus receives the request data from each page. If a page has multiple
events, then the Event Bus receives a single hit.

* The event data is sent to the event bus only if the Send to Event Bus option is
enabled for an event. See "TEM Events Tab" in the IBM Tealeaf Event Manager
Manual.

* In addition to the existing request data, an extra section is added to the request.
See “Event Bus request variables” on page 34.

* For a sample CEP section of data for the request, see “Sample Event Bus
request.”

The response data is available to the Event Bus pipeline.

Note: Because of the unstructured nature of the response data, none of the
integration pipeline agents to external systems use the response data.

Event Bus packets
Event Bus packets are sent to the destination system on the following event
triggers or conditions:

» Start of Session
— Contains: hit-based facts
+ After Every Hit
— Contains: hit-based facts
* End of Session
— Contains:
1. Fact and event data that is derived from last hit of session
2. Facts marked for reporting on last instance in the session

3. End of Session trigger evaluation

Note: Events that are configured to close a session are automatically sent
to the Event Bus when it is enabled. The request data in these packets is
provided from the last hit of the session.

At the end of a session, an "end of session" signal event is sent to the Event Bus
pipeline. The UniquelD of the hit is -1.

Additional event bus configuration information

Sample Event Bus request

The following request text is a sample output from the Canister to the Event Bus
pipeline.

[iamie]
TLTSID=EE67713899435C0572EA592C29F3EFF3
TLTHID=34A9A04D49347BA3DCO1BO16652A296A
TLTUID=342821467A0B0O3D336BB8127E6019019
LOADGEN_DATA=TRUE
CaptureSource=TealLeafPassiveCapture2
CaptureType=1

CaptureVersion=3305

[env]
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REMOTE_ADDR=63.194.158.183

REMOTE_PORT=1639

LOCAL_ADDR=63.194.158.210

LOCAL_PORT=80

SERVER_NAME=63.194.158.210

SERVER_PORT=80

HTTPS=off

CONNECTION_ID=11730

PCA_NAME=jupiter

PCA_ADDR=127.0.0.1

PCA_UNAME_RELEASE=2.6.9-55.EL

PCA_UNAME_SYSNAME=L1nux

REQ_BUFFER_ENCODING=UTF-8

REQ_BUFFER_ORIG_ENCODING=IS0-8859-1

REQUEST_METHOD=GET

URL=/store/index.php/foresee

SERVER_PROTOCOL=HTTP/1.1

ResponseType=text/html; charset=UTF-8

StatusCode=200

StatusCodeText=0K

RequestHeaderSize=801

RequestDataSize=0

RequestSize=801

ResponseHeaderSize=428

ResponseDataSize=18404

ResponseSize=18832

RESP_BODY_ENCODING=utf-8

ReqCancelled=False

RegDiscarded=False

StreamingHit=False

StreamingHitType=0

HTTP_ACCEPT=+/=*

HTTP_ACCEPT_LANGUAGE=en-us

HTTP_UA_CPU=x86

HTTP_ACCEPT_ENCODING=gzip, deflate

HTTP_USER_AGENT=Mozilla/4.0 (compatible; MSIE 7.0; Windows NT 5.1;

.NET CLR 1.1.4322; .NET CLR 2.0.50727; MS-RTC LM 8)

HTTP_HOST=www.straussandplesser.com

HTTP_CONNECTION=Keep-Alive

HTTP_COOKIE=magento=furtlzy7tijjvxcnlpccoc64hs3ew5rk;
frontend=j5mdcegl15ucj2rrerc4ep8ul0;
TLTHID=8E6A041C52741052026CF311152600F5;
TLTSID=3B9E220E52741052026485ECEFDAFO8A;
TLTUID=3B9E220E52741052026485ECEFDAFO8A;
__utma=131544653.2442909905711142000.1216148505.1216148505.1216148505.1;
__utmb=131544653.2.10.1216148505;
__utmc=131544653;
__utmz=131544653.1216148505.1.1.utmcsr=(direct) |utmccn=(direct) |

utmemd=(none) ;

__utmv=131544653.TLTSID%2F3B9E220E52741052026485ECEFDAFO8A;
s_cc=true;
s_sq=%5B%5BB%5D%5D

HTTP_SET_COOKIE=TLTHID=DC459D6A5277105200D780232AB9484E; Path=/;

Domain=.straussandplesser.com
TRANSFER_ENCODING=chunked

[TimeBlock]
WEEK=35

MONTH=8
QUARTER=3
YEAR=2010
HOUR_OF DAY=10
DAY OF WEEK=1
DAY_OF MONTH=23
DAY_OF_YEAR=235
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[timestamp]
RequestTimeEx=2010-08-23T17:27:34.000Z
ResponseStartTimeEx=2010-08-23T17:27:34.019Z
ResponseTimeEx=2010-08-23T17:27:34.019Z
ResponseAckTimeEx=2008-07-15T19:27:44.087781Z
TLapiArrival TimeEx=2008-07-15T19:27:44.088415Z
ReqTTLB=0

RspTTFB=576964

RspTTLB=17197

RspTTLA=260

ConnSpeed=8630119

ConnType=T1

WS_Generation=576964

WS_Grade=NormalWS

WS_GradeEx=1

NT_Total=17457

NT_Grade=ExcellentNT

NT_GradeEx=0

RT_Total=594421

RT_Grade=NormalRT

RT_GradeEx=1

[urlfield]

[cookies]
TLTHID=DC459D6A5277105200D780232AB9484E
magento=furtlzy7tijjvxcnlpccoc64hs3ewbrk
frontend=j5mécegll5ucj2rrercdep8uld
TLTHID=8E6A041C52741052026CF311152600F5
TLTSID=3B9E220E52741052026485ECEFD4FO8A
TLTUID=3B9E220E52741052026485ECEFD4AFO8A

__utma=131544653.2442909905711142000.1216148505.1216148505.1216148505.1

__utmb=131544653.2.10.1216148505
__utmc=131544653

_ utmz=131544653.1216148505.1.1.utmcsr=(direct
__utmv=131544653.TLTSID/3B9E220E52741052026485
s_cc=true

s_sq=[[B]]

TLT_NumCookies=13

[appdatal
REMOTE_ADDR=63.194.158.183
Request_Method=GET

TLT_URL=/store/index.php/foresee
TLT_SERVER=63.194.158.210
TLT_HOST_NAME=www.straussandplesser.com
TLT_APPLICATION_NAME=store

[ExtendedUserAgent]
TLT_BROWSER=IE
TLT_BROWSER_VERSION=IE7.0
TLT_BROWSER_PLATFORM=WinXP
TLT_TRAFFIC_TYPE=BROWSER
TLT_BROWSER_JAVASCRIPT=true
TLT_BROWSER_COOKIES=true

[TLFID 283]

TLFID=283

TLEventID=57
TLFactValue=EE67713899435C0572EA592C29F3EFF3
TLFactNumericValue=0.0

TLDimGroupID=1

) |utmcen=(direct) |utmemd=(none)
ECEFD4FO8A
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TLDim1=TLT$NULL
TLDim2=TLT$NULL
TLDim3=TLT$NULL
TLDim4=TLT$NULL

[TLFID_284]

TLFID=284

TLEventID=57
TLFactValue=EE67713899435C0572EA592C29F3EFF3
TLFactNumericValue=0.0

TLDimGroupID=3

TLDim1=BROWSER

TLDim2=TLT$NULL

TLDim3=TLT$NULL

TLDim4=TLT$NULL

[TLFID 285]

TLFID=285

TLEventID=57
TLFactValue=EE67713899435C0572EA592C29F3EFF3
TLFactNumericValue=0.0

TLDimGroupID=5
TLDiml=/store/index.php/foresee
TLDim2=www.straussandplesser.com
TLDim3=store

TLDim4=63.194.158.210

[CEP]

EventBusFormat=8.0
Canister=SIERRA4
SesnIdx=943874
HitNumber=6
DateTime=1282584454
CustomVarl=63.194.158.183
DiscardedSession=false

Event Bus request variables: In the above request, the Canister inserts the [CEP]

section when the Event Bus is enabled. The [CEP] request variables are described

below:

* The fact data included in the request contains the event and dimension data
usable by the destination system.

Variable
Description

EventBusFormat
Output format of the Event Bus.

Note: The Event Bus format number is independent of the Tealeaf Release
or build number. The Event Bus version may be incremented at any time.

Canister
The name of the Canister that generated the Event Bus information

SesnIdx
The Canister session index identifier

HitNumber
The hit number for the session

DateTime
The timestamp in seconds in UNIX time (GMT, number of seconds since
1970)
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CustomVarX
If one or more session attributes were specified for the session, they and
their values are listed in this section.

DiscardedSession
If this value is set to true, the session Sesnldx in Canister was marked for
discarding.

* This property is used by the IBM Tealeaf cxReveal database, which is
populated by [CEP] data to maintain session attribute and session state
information. See "Configuring Session Attribute Search" in the IBM
Tealeaf cxReveal Administration Manual.

Coral8 Server
To use the Coral8 Server with the Event Bus, you must do the following
installation and configuration steps:
1. Install the Coral8 Server product on a server. It is recommended that this
server is a different one from the Tealeaf server.
* For more information, visit http:/ /www.aleri.com.
2. Copy the Coral8.d11 from the \Coral8\Server\Sdk\Net directory on the
Coral8 server to the Tealeaf installation directory on the Tealeaf server.
3. Install the Coral8 Studio and load the Tealeaf project file. The project should
be initially installed in the Default workspace.
4. Copy the Tealeaf.Pipeline.CEP.d11 to the Tealeaf install directory.
5. Modify the TeaLeafEventBus.cfg file. Change the [DecoupleEx]
DownStreamConfigSection to CEP.

6. In the [CEP] section, modify the URI value to the correct server address. In
most cases, you can change the value Tocalhost to the correct server name or
IP address.

7. Modify the CEPCustomFields.cfg file, if necessary. This modification can be
done after the system is running.

8. Through TMS, enable the Event Bus in Canister configuration.

* See "Configuring the CX Canister" in the IBM Tealeaf CX Configuration
Manual.

9. Use the Capture Status utility to see the status of the Event Bus.

* See "TeaLeaf Capture Status - Pipeline Monitoring Utility" in the IBM Tealeaf
CX Configuration Manual.

10. Check the NT Event log for any errors.

The Tealeaf.Pipeline.CEP.d11 session agent creates the following log files:

* SA_CEP_C8 CANISTER_EVENT YYYYMMDD.log - This log file outputs all the
connection status information. Use this file to diagnose connection problems.

e SA_CEP_C8_CANISTER_EVENT_STATS_YYYYMMDD.Tog - This log file only outputs
processing statistics and does not contain any error information.

Coral8 Studio should be used to view the incoming stream data.

TCP connector with delimited message
The TCP connector sends a delimited message to a receiver for each event bus hit.
The message is formatted with a delimiter and an optional end-of-record indicator.

e If the text in the message contains the delimiter, then the character is
URL-encoded in the string. For example, the comma character (,) would be
encoded as %2C.
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The end-of-record indicator can be one of the following values:
* Blank - no value

e LF - line feed (\n)

* CRLF - carriage return with line feed (\r\n)

The following is an example of the configuration in the TealLeafEventBus.cfg file:

TCP=ON

TCP_Server=localhost

TCP_Port=1971

TCP_Delim=,

# Record Terminator values (CRLF, LF, or blank)
TCP_RecTerminator=LF

TCP file schema

The TCP connector uses the default schema.
* See “Tealeaf Event Bus” on page 25.

Log File Connector with delimited data
The Log File Connector sends a delimited message to a log file for each event bus
hit. The message is formatted with a delimiter as specified by the configuration.

e If the text in the message contains the delimiter, then the character is URL
encoded in the string. For example, the comma character (,) would be encoded
as %2C.

* The line length limit is 10,000 characters, including the delimiters.

Note: This output connector should be implemented only on a dedicated file
server with a Tealeaf pipeline. This connector allows several input sources to
write to the same log file at one time and frees up disk I/O from the main
Tealeaf system.

Below the FILE_Directory, a new directory is created for each day of data with a
directory name in YYYYMMDD format. The log file names have the following format:

TL_EB O _YYYYMMDD mmmm.1og

Where:

* YYYY - year

* MM - month

* DD - day

e mmmm - Number of minutes past midnight for current day: 0000 - 1439

These files are structured in the following manner:

QutputType=FILE

File Delim: any character or TAB (note: not CSV compliant)
FILE Delim=|

FILE Directory=c:\tealeaf\logfiles

Row Time in minutes - Tog will be rolled every N minutes
FILE_Ro11Time=5

Log File schema

The Log connector uses the default schema.

¢ See “Tealeaf Event Bus” on page 25.
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Chapter 4. cxReveal User Administration

The IBM Tealeaf cxImpact, IBM Tealeaf cxReveal and IBM Tealeaf cxView user
administration sections are very similar, but there are differences in the settings for
each. The three types of users and groups they manage have very different roles.

To access IBM Tealeaf cxReveal User Administration:
1. Login to the Portal as an administrator.
2. From the Portal menu, select Tealeaf > Portal Management.

3. The Portal Management page is displayed. In the left panel, click IBM Tealeaf
cxReveal User Administration.

4. Select the category that applies:
a. “Users”
b. “Groups” on page 41
C. “Current Users” on page 45

Note: Changes to settings saved in the Portal Management page are not applied to
the Portal application until the page is refreshed through your browser.

Note: If you have installed this product as part of a new installation of Tealeaf,
access to product features through the Portal are provided to the ADMIN group
automatically. Automatic access is also granted if you have licensed this product
for an existing Tealeaf solution and have not modified your ADMIN group
permissions since original installation.

* If you have modified the ADMIN group and are deploying this product to an
existing Tealeaf solution, you must update menu permissions manually for that
group.

¢ For all other users and groups, you must configure the appropriate permissions.

Note: By default, IBM Tealeaf cxReveal accounts created in a new install are
assigned to the cxReveal User group, since most IBM Tealeaf cxReveal accounts
require only this level of access. After the account is created, admin-level
permissions can be assigned through this screen to individual accounts. Account
assignments and permissions are not altered on upgrade.

Users

Click Users to see a list of all IBM Tealeaf cxReveal users.

Select a user and click one of the buttons above the list to make changes.

New / Edit

Click New to create a new user, or select an existing user from the list and click
Edit to open the user properties dialog

Some of the properties can be set to Primary Group Default, which means the
user inherits the setting from the user's primary group, which is specified in the
Primary User Group property.

Setting Description
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Active If this box is deselected, the user cannot login or receive emails.
ID This system-generated number is used internally to identify the account.

Username
The login name for the user.

Note: Tealeaf recommends using only alphanumeric characters when
specifying names used by the Portal application. Some non-alphanumeric
characters may be blocked or may cause issues for some Tealeaf
components.

NT Username
If NT authentication is in use, this value is the NT/AD user name for the
user.

NT Domain
If NT authentication is in use, this value is the NT/AD domain for the
user.

Email Enter a valid email address for delivery of results set analysis, scheduled
dashboards, alerts, and other Tealeaf content.

Time Zone (used in Search)
Hourly report values are displayed in the user's timezone, but the daily
rollup of reporting data is controlled by the system timezone. It is best to
set this value to the same as the system timezone to avoid confusion.

* This time zone setting applies primarily to the affected users' search
activities. Other Portal activities utilize the Tealeaf system time zone. See
"Configuring the System Timezone" in the IBM Tealeaf CX Configuration
Manual.

System Locale
Select the user's preferred system locale. The system locale setting defines
how currency, numeric values, date, and time are formatted are displayed.

This setting defaults to the Primary Group Default at the user level. The
administrator can manage this setting by selecting a system locale for each
user group.

Date Format
Select the format, such as mm/dd/yyyy, from the list. The Date Format
setting defaults to the Primary Group Default date. The Primary Group
Default uses the selected date format setting that is assigned to the user
group. If you want to specify a custom system locale for a user, you can
configure the System Locale setting then, select Use system locale for the
date format. If you want to use a date format that is unrelated to the
system locale setting, you can select a custom date format from the list.

Language
The language the Portal should display for the user.

Password Expires
The number of days after which the Portal does not permit a user from
continuing after login until the user has configured a new password.

Start Page
The list of available start pages depends on the user's group and menu
permissions.
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Portal Navigation Menu
Enables or disables the user's ability to see the top navigation menu in the
Portal.

Log User Out If Idle
When enabled, the user is logged out if the session is idle for a period
longer than the session timeout length.

* You can change the timeout length through Report configuration. See
"Configuring the Report Server" in the IBM Tealeaf CX Configuration
Manual.

Allow Report Template Import
When enabled, the user is permitted to import report templates. When set
to Primary Group Default, the user inherits the default setting for the
primary group.
* All users can export report templates regardless of this setting.

Create Combined Session Segment
Enables or disables the Build Combined Segment feature in the Manage
Session Segments page for IBM Tealeaf cxReveal users. See "Managing
Session Segments" in the IBM Tealeaf cxResults User Manual.

Lock Replay Mode
Enables or disables the user's ability to change his or her Replay Mode.

Replay Mode
The following values are available:
e RTV - Launch the IBM Tealeaf CX RealiTea Viewer desktop application to
replay sessions. The app must be already installed on the user's desktop.
* Browser - Replay sessions inside the browser.

* Prompt on Replay - Open a dialog in which the user can choose RTV or
Browser for every replay.

Default Active Search Template
The default search template to load when the user chooses to search for
active sessions.

Default Completed Search Template
The default search template to load when the user chooses to search for
completed sessions.

Default A11 Sessions Search Template
The default search template to load when the user chooses to search for all
sessions.

Search Box for Online Help
Enable or disable the Online Help search box available at the top of each
Portal page.

Open BBR In A New Window
When enabled, sessions loaded in Browser Based Replay are displayed in a
new browser window.

Primary User Group
The primary group to use for group level settings.

Member Of
Lists all groups of which the user is currently a member.

Click Save to apply your changes, or click Cancel to quit without applying them.
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Password

To change a password, select a user and click Password. Enter the new user's
password twice in the New Password and Confirm New Password fields. Click
Save to apply the change.

Force Password Change

To force the user to change his or her password, select a user and click Force
Password Change. The next time the user logs in, he or she is required to change
the account password before using the Portal.

Clear Password History

Reset the user's password history, allowing the user to re-use passwords that might
have conflicted with the Portal's password usage policy.

Assign Groups

Select a user and click Assign Groups to assign the user to one or more groups. To
switch a user's role, remove the user from all groups, and then add a group for the
user's new role.

Manage NT Users

When NT authentication is enabled in the Portal, Tealeaf administrators can use
this feature to create and disable Portal accounts based on Windows domain logins
detected by the Portal.

* For more information on authentication, see "Authentication" in the IBM Tealeaf
cxImpact Administration Manual.

e NT authentication is enabled through Search Server configuration. See
"Configuring the Search Server" in the IBM Tealeaf CX Configuration Manual.

* If desired, you can configure the Portal to automatically login and create
accounts for any NT user who visits the Tealeaf Portal. See "CX Settings" in the
IBM Tealeaf cxImpact Administration Manual.

Left pane: NT users who do not have Portal accounts
Right pane: Current Portal accounts

e To mark an NT user for Portal account creation, select the user, and click the >>
arrow.

* To disable a Portal account, select the user, and click the << arrow.
* To save these changes, click Save. The marked accounts are created or disabled.

View Activity

This button links to the Audit page, which lists Portal activity for the selected user.
For more information see the "Audit page" section.

Delete

Deletes the selected user's profile completely, as well as any dashboards and
scorecards created by that user.

Note:

1. When you delete a user account, any scorecard schedules or dashboards
created by the user are removed. To avoid this deletion, you may change the
password on the user account instead.
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2. The Admin user cannot be deleted.

Groups

Under IBM Tealeaf cxReveal User Administration, click Groups to display a list of
the groups.

New / Edit

Click New to create a new group, or select a group from the list and click Edit to
open the group properties dialog.

User groups have the following properties. All settings except for the Group Name
setting can be inherited by users who have the selected group set as their Primary
User Group.

Setting Description
ID This system-generated number is used internally to identify the group.

Group Name
The name of the group.

Note: Tealeaf recommends using only alphanumeric characters when
specifying names used by the Portal application. Some non-alphanumeric
characters may be blocked or may cause issues for some Tealeaf
components.

Default Time Zone (used in Search)
Hourly report values are displayed in the user's timezone, but the daily
rollup of reporting data is controlled by the system timezone. It is best to
set this value to the same as the system timezone to avoid confusion.

¢ This time zone setting applies primarily to the affected users' search
activities. Other Portal activities utilize the Tealeaf system time zone. See
"Configuring the System Timezone" in the IBM Tealeaf CX Configuration
Manual.

Default System Locale
Select your preferred system locale. This setting applies the selected
regional formatting to dates, time, and numeric values that are displayed
to the user within the Tealeaf Portal.

Default Date Format
Select the format, such as mm/dd/yyyy, from the list. By default, the date
format is set to the date format of the configured system locale.

Default Language
The language the Portal should display for the user group.

Default Start Page
The list of available start pages depends on the user's group and menu
permissions.

Default Password Expiration
This option requires all users to change their passwords every N days.
After the password expires, the portal does not let the user continue after
login until a new password has been set.

Password Expiration Warning Period
The number of days before password expiration for which the system
warns users that their passwords are about to expire.

Chapter 4. cxReveal User Administration 41



42

Default Portal Navigation Menu
Enable or disable the group's ability to see the top navigation menu in the
Portal.

Default Log User Out If Idle
When enabled, members of the group are automatically logged out if their
sessions are idle for a period longer than the session timeout length.
* You can change the timeout length through Report configuration. See

"Configuring the Report Server" in the IBM Tealeaf CX Configuration
Manual.

Default Allow Report Template Import
When enabled, this setting allows all users of the group to import report
templates by default. This setting can be overridden by settings to
individual user accounts.

* By default, admin accounts are configured to allow report import.

 All users can export report templates regardless of this setting.

Default Create Combined Session Segment
Enable or disable the IBM Tealeaf cxReveal group's ability to use the Build
Combined Segment feature in the Manage Session Segments page. See
"Managing Session Segments" in the IBM Tealeaf cxResults User Manual.

Default Lock Replay Mode
Enable or disable the group's ability to change Replay Mode.

Default Replay Mode
The following options are available:
¢ RTV - Launch the IBM Tealeaf CX RealiTea Viewer desktop application to
replay sessions. The app must be installed on the local desktops of users
in the group.
* Browser - Replay sessions inside the browser.
* Prompt on Replay - Pop up a dialog to choose RTV or Browser for every
replay.
Default Active Search Template

The default search template to load when the members of the group
choose to search for active sessions.

Default Completed Search Template
The default search template to load when the members of the group
choose to search for completed sessions.

Default A1l Sessions Search Template
The default search template to load when the members of the group
choose to search for all sessions.

Search Box for Online Help
Enable or disable the Online Help search box available at the top of each
Portal page for the group.

Open BBR In New Window
When enabled, sessions loaded in Browser Based Replay are displayed in a
new window for the group.

Assign Users

Click Assign Users to add users to the selected group.
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The list is populated with users who are of the correct role (IBM Tealeaf cxImpact,
IBM Tealeaf cxView, or IBM Tealeaf cxReveal) and users who are members of
absolutely no other groups.

Including users without groups allows you to transition users between roles. To
move a user to a new role, remove all group assignments from the user, and then
assign the user to another group that matches the new role.

Menu Profile

The Menu Profile for a user group determines the menu options that a group's
members can access. It also controls which reports can be viewed on the
dashboards of a group's members. For example, if a group does not have
permission in the menu profile for Analyze > Report Builder, its members cannot
view the Report Builder page or any reports generated by other Tealeaf users.

Note: IBM Tealeaf cxReveal provides a set of menu options that has been reduced
from the menu options available to IBM Tealeaf cxImpact users. For more
information on available menu options in IBM Tealeaf cxImpact, see "Portal
Navigation" in the IBM Tealeaf cxImpact User Manual.

Note: After you modify a user group's menu profile, you should verify that the
users in the group can still access their default page. This page is defined at the
group level in the Default Start Page setting and is also available for individual
user configuration. Users who cannot access their default page are forced to review
their settings. See "My Settings" in the IBM Tealeaf cxImpact User Manual.

Administration Profile

For groups granted access to the Portal Management page, the Administration
Profile controls the portions of the page that they can see. The items in the list
correspond to the sections on the Administration page sidebar.

Search Profile

For groups granted access to the Session Search page, the Search Profile controls
the search options members that they can see and the search templates that they
are allowed to use. If a user has no search options available, the options section is
hidden entirely on the Session Search page.

Browser Replay Profile A

For groups that are granted access to Browser Based Replay (BBR), the Browser
Replay Profile controls the actions and permissions to which group members have
access while using BBR. The replay and navigation sections of BBR are available to
all users, but other functions are controlled by the Browser Replay Profile.

* See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User Manual
* See "BBR Options" in the IBM Tealeaf cxImpact User Manual

* You can configure rules for BBR replay through the Portal Management page.
See "BBR Replay Rules" in the IBM Tealeaf cxImpact User Manual.

Browser replay profile B
Setting Description

View Request
When selected, users in this group can access BBR Request view.
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View Response
When selected, users in this group can access BBR Response view.

View Events
When selected, users in this group can access the Events pane.

View URL Fields
When selected, users in this group can view the URL fields in the left-hand
panes.

View Gen Time
When selected, the Gen Time statistic is displayed in the page statistics bar.

See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User
Manual.

View Net Trip Time
When selected, the Net Trip Time statistic is displayed in the page statistics
bar.

See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User
Manual.

View Round Trip Time
When selected, the Round Trip Time statistic is displayed in the page
statistics bar.

See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User
Manual.

View Bytes
When selected, the size of the response in bytes is displayed in the page
statistics bar.

See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User
Manual.

View Status Code
When selected, the status code of the response is displayed in the page
statistics bar.

See "Browser Based Replay Interface" in the IBM Tealeaf cxImpact User
Manual.

Actions

Setting Description

Enable Searching
When selected, users in this group can copy text selections and use them to
execute searches of completed sessions from within BBR.

Enable Email Sessions
When selected, users in this group can email links to sessions opened in
BBR.

Settings
Setting Description

Use Page Titles Instead of URLs
When selected, this option is available in the drop-down menu. When it is
selected, the Page Title of each page is listed in the Navigation panel,
instead of the URL.
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Merge Session Fragments
When selected, this option is available in the drop-down menu. When it is
selected, users in this group can configure and execute the merging of
session fragments.

Merging session fragments enables the stitching together of fragments of
an individual session that has been splintered by timeout, traffic issues, or
other factors. The configured behavior can be overridden through the
interface. See "BBR Options" in the IBM Tealeaf cxImpact User Manual.

Report Javascript Errors
When selected, this option is available in the drop-down menu. When it is
selected, Javascript errors are reported to the BBR user.

Resize Replay Pane To Match Sessions
When selected, this option is available in the drop-down menu. When it is
selected, the replay pane in BBR is automatically resized to match the
screen dimensions used by the visitor's user agent.

Advanced Options
Select this option to enable the ability to load Tealeaf archive files into BBR
for replay.

Note: TLA files loaded through BBR do not have On-Demand Privacy
rules applied to them and may pose a security risk if this feature is
enabled. See "On-Demand Privacy" in the IBM Tealeaf CX Configuration
Manual.

* Replay rules are applied to loaded TLA files.

* For more information on these settings in BBR, see "BBR Options" in the
IBM Tealeaf cxImpact User Manual.

Delete

Deletes the selected group. The group's members are not deleted.

Current Users

Displays a list of the currently active users of the specified role. The user's name is
a link to the Audit page, which displays the user's activity.

Portal Menu Bar

In many implementations, IBM Tealeaf cxReveal users do not require access to a
Portal menu bar, as users' primary functions are searching for sessions and then
replaying found sessions. Depending on your user account permissions, you may
not be able to see a menu inside the Portal.

If needed, Tealeaf administrators can configure the menu profile for individual
IBM Tealeaf cxReveal users or IBM Tealeaf cxReveal user groups to include a menu
bar in the Portal.

Note: A user's menu profile is defined as the union of the menu profiles of all user
groups to which the user belongs. For example, if the user belongs to two user
groups, the menu profiles of each group are applied to the user.

* If a specific permission is enabled for one group and disabled for another group
to which the user belongs, then the menu item is enabled.
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For cxReveal Groups

To make menu bar changes for IBM Tealeaf cxReveal groups, please complete the
following steps.

Login to the Portal as an administrator.

From the menu, select Tealeaf > Portal Management.

In the left panel, click the IBM Tealeaf cxReveal User Administration link.
Click the Groups link.

Select the group whose menu profile you'd like to change.

ook wn =

From the Default Portal Navigation Menu setting, you may select one of the
following options:

e Enable - Enable the Portal menu for this user group.
* Disable - Disable the Portal menu for this user group.

— IBM Tealeaf cxReveal users in this group are placed in the page specified
in the Default Start Page setting. Typically, this value is set to Default
Search Template for IBM Tealeaf cxReveal users.

7. To configure a menu profile for the group, click Menu Profile.

8. In the Menu navigation tree, you can select the menus and menu items to
display to members of this group.

9. To save changes, click Save.
¢ See “Menu Profile” on page 43.

For Individual cxReveal Users

To make menu bar changes for individual IBM Tealeaf cxReveal users, please
complete the following steps.

1. Login to the Portal as an administrator.

From the menu, select Tealeaf > Portal Management.

In the left panel, click the IBM Tealeaf cxReveal User Administration link.
Click the Users link.

Select the user whose menu profile you'd like to enable.

Click Edit.

From the Portal Navigation Menu setting, you may select one of the following
options:

N o~

e Primary Group Default - This user inherits its menu profile settings from the
primary user group configured for the user. This group is listed under the
Primary User Group setting for the user account.

* Enable - Enables a menu profile for this individual user.

* Disable - Disables a menu profile for this individual user.
8. To save changes, click Save.

* See “Users” on page 37.
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Chapter 5. cxReveal Settings

These settings govern the behavior of IBM Tealeaf cxReveal, which is used to

search, analyze, and replay visitor sessions.

To accessIBM TealeafcxReveal settings:

1. Login to the Portal as an administrator.

2. From the Portal menu, select Tealeaf > Portal Management.

3. The Portal Management page is displayed. In the left panel, click IBM Tealeaf

cxReveal Settings.
4. Select the category that applies.

Note: Changes to settings saved in the Portal Management page are not applied to

the Portal application until the page is refreshed through your browser.

Search

Table 3. Search

cxReveal search settings control how session searches are configured and retrieved.

Searches may return a high number of sessions, so some settings can be used to

limit the volume of retrieved data.

Dimensions

Setting Description Default
BBR Annotation | Administrators can configure the list of N/A
Options pre-selected annotation options available in
Browser-Based Replay. Select this option and
scroll down to review and update the list. Users
can also create their own annotations through
BBR
* See "Tracking Interactions through BBR" in
the IBM Tealeaf cxImpact User Manual.
Completed Max |Max number of sessions to return for a 100
Results Limit |completed session search. See "CX Settings" in
the IBM Tealeaf cxImpact Administration Manual.
Default The session list template to use for drill-down <Default>
Session List searches for IBM Tealeaf cxReveal users.
Template * Searches executed from the Portal search page
utilize the assigned or selected session list
template. See "Searching Session Data" in the
IBM Tealeaf cxImpact User Manual.
Display Event |Toggle display of tooltips for events. Enabled
Info Tooltips
Display Show /hide PCA information when drilling EnabTled
Passive down to a specific page of a session.
Capture Info
Event Image The maximum number of events to display in 20
Display Max the Event List column on the Session List.
Event Selector |The initial size for the Event Selector. 2x1
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Table 3. Search (continued)

Search Tables
- Days Retain

* This setting applies only if you have installed
the IBM Tealeaf cxReveal database. See
"cxReveal Installation" in the IBM Tealeaf
cxReveal Administration Manual.

Setting Description Default
Hit Detail Enables the Page Detail view in search results Enabled
Enabled (Session List > Session Detail > Page Detail).
Live Max The maximum number of active sessions to 100
Results Limit |return from an active search. See "CX Settings"
in the IBM Tealeaf cxImpact Administration
Manual.
Log Search When enabled, searches of the IBM Tealeaf Disabled
Database cxReveal database are logged.
Searches * This setting is present only if the IBM Tealeaf
cxReveal database has been installed.
* The number of days that logs are retained is
defined by Search Database Log - Days
Retain.
Open Browser Enables the removal of toolbars and buttons Enabled
Replay In from the Browser-Based Replay window, which
Featureless will force a new window and not a new tab in
Window the browser.
Require At When enabled, searches executed through IBM | Disabled
Least One Tealeaf cxReveal must contain at least one
Populated populated search field to limit their scope.
Search Field
Results Per The page size of the session list grid in search |20
Page results.
Search When Log Search Database Searches is 7
Database Log - |enabled, this setting defines the number of days
Days Retain for which logs of IBM Tealeaf cxReveal database
searches are retained.
* This setting is present only if the IBM Tealeaf
cxReveal database has been installed.
Search Specifies the maximum number of sessions that |100
Database Max can be returned from a database search.
Sessions * This setting defines the volume of search data
Returned returned from the IBM Tealeaf cxReveal
Search database. Other settings that limit the
number of displayed sessions, such as
Completed Max Results Limit, may be
applied afterward, further limiting the
number of search results.
Search This setting defines the maximum amount of 60
Database time in seconds that a search is permitted to run
Search Timeout |before it times out.
(seconds) + This setting applies only if you have installed
the IBM Tealeaf cxReveal database. See
"cxReveal Installation” in the IBM Tealeaf
cxReveal Administration Manual.
Search Number of days of session attribute data to 30
Database retain in the IBM Tealeaf cxReveal database
Session tables
Attribute
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Table 3. Search (continued)

Setting Description Default
Search For IBM Tealeaf cxReveal, this setting defines 60
Database the number of minutes that are permitted to

Session elapse without additional activity, after which

Timeout the session is automatically timed out. See

(minutes) "Configuring Session Attribute Search" in the

IBM Tealeaf cxReveal Administration Manual.

* This setting applies only if you have installed
the IBM Tealeaf cxReveal database. See
"cxReveal Installation" in the IBM Tealeaf
cxReveal Administration Manual.

Session Detail |The field to retrieve the URL for each page in env/URL
Path Variable |session detail.
Use Canister When enabled, searches executed against the Enabled

Data for
Database
Search Results

IBM Tealeaf cxReveal database to retrieve
session attribute information also gather session
information from the Canisters where the
matching sessions are stored.

Note: Tealeaf recommends keeping this setting
enabled, which is the default configuration.
However, if performance degrades significantly
for searches against the IBM Tealeaf cxReveal
database, you may try disabling this setting. See
"Configuring Session Attribute Search" in the
IBM Tealeaf cxReveal Administration Manual.

Users

These IBM Tealeaf cxReveal settings control creation of user accounts, password

policies, and default user settings.

Table 4. Users

Setting Description Default
Automatic If NT Auth is enabled, this setting Enabled
User allows for new users to have Portal
Creation accounts automatically created on

first login.
Automatic Enables first-time users to specify Disabled
User their user settings immediately upon
Creation login.
Settings
Prompt
Login Page |The language used on the global English (US)
Language login page. After the user logs in, the
(Global) user's preferred language is known.
Minimum Minimum password length for user |3
Password passwords.
Length

Portal passwords can have a

maximum length of 32 characters.
New User The default start page to assign to Report Builder
Default automatically created users.
Page
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Table 4. Users (continued)

Setting Description Default
New User The default timezone to assign System time zone
Default automatically created users. This
Time Zone |setting is used for display in search.
(used in
search) By default, this value is set to the
Tealeaf system time zone. See
"Configuring the System Timezone"
in the IBM Tealeaf CX Configuration
Manual.
Previous Number of unique passwords a user |Disabled
Password must have before reusing a password.
History
(Count)
Previous Number of days that must pass Disabled
Password before a user can reuse a password.
History
(Days)
Require Require passwords to meet the Disabled
Strong 'strong password' requirements.
Passwords
User The user group to assign to cxReveal User
Default automatically created users, one for
Group each role: IBM Tealeaf cxImpact, IBM
Tealeaf cxReveal, or IBM Tealeaf
cxView.
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Chapter 6. Configuring Session Attribute Search

IBM Tealeaf cxReveal provides the ability to search for sessions by session
attribute. When configured session attributes are detected in a visitor session, those
attributes and other session-related information are inserted into the IBM Tealeaf
cxReveal database (TL_SEARCH) where they are immediately available for search.
Through session attribute search, IBM Tealeaf cxReveal users can access visitor
sessions quickly and immediately after they have been created.

Note: Session attribute search is a component of cxReveal, a separately licensable
component of the Tealeaf CX platform. please contact your IBM Tealeaf
representative.

This section describes the sequence of steps required to enable, configure, and test
searching by session attribute.

Pre-Requirements

Before you begin configuring session attribute search, please verify the following:

IBM Tealeaf cxReveal has been licensed, and the license key has been enabled.

Based on your traffic load, you should determine the number of IBM Tealeaf
cxReveal servers to deploy in your Tealeaf environment.

Note: Tealeaf supports the deployment of multiple IBM Tealeaf cxReveal
Servers. See Chapter 2, “cxReveal Installation,” on page 9.

At least one IBM Tealeaf cxReveal machine has been installed and integrated
into the network. Machine must meet Tealeaf pipeline and Database Server
requirements. See "CX Pre-Installation Checklist" in the IBM Tealeaf CX
Installation Manual.

IBM Tealeaf cxReveal database has been installed on a server hosting a
dedicated SQL Server instance.

— See "CX Installation and Setup" in the IBM Tealeaf CX Installation Manual.
— See "Using Tealeaf Database Manager" in the IBM Tealeaf Databases Guide.

Through the IBM Tealeaf cxImpact installer, the IBM Tealeaf cxReveal pipeline
has been installed on each IBM Tealeaf cxReveal machine capturing session
attribute data.

— See Chapter 2, “cxReveal Installation,” on page 9.

Session attribute search requires the Tealeaf Event Bus, a feature of IBM Tealeaf
cxConnect for Data Analysis.

Note: Tealeaf Event Bus is a component of cxConnect for Data Analysis, a
separately licensable component of the Tealeaf CX platform. please contact your
IBM Tealeaf representative.

— See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis
Administration Manual.

Configuration

After the above requirements have been applied to your Tealeaf solution, please
complete the following configuration sections in the listed order.
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Configuration Steps

In the following sequence, you can review the list of steps required to enable and
configure session attribute search, including links to topics within this section.

1. Configure session attributes: Before you begin using session attribute search,
you should verify that you have configured all of the session attributes on
which you would like to search. See “Changing Session Attributes” on page 53.

¢ This section also includes some simple tests to verify that the preconfigured
session attributes are being populated. See “Defining database search fields
through session attributes” on page 53.

2. Configure IBM Tealeaf cxReveal session timeout: By default, IBM Tealeaf
cxReveal sessions time out in 60 minutes. You can change this setting. For more
information on this setting and the behaviors in IBM Tealeaf cxReveal, see
“cxReveal session timeouts” on page 61.

3. Configure search templates: Database search requires a different type of search
template and session list template.

a. See “Configure cxReveal Search Templates” on page 55.
b. See “Configure Session List Templates” on page 57.

4. Configure Events: As part of this configuration, events must be configured to
be sent via the Event Bus to the IBM Tealeaf cxReveal Server(s).

* See "TEM Events Tab" in the IBM Tealeaf Event Manager Manual.

5. Enable and configure IBM Tealeaf cxReveal capture: Session attribute search
requires a dedicated pipeline on a separate machine to capture session
attributes for insertion into the IBM Tealeaf cxReveal database. For more
information on those configuration tasks, see “Configure Session Attribute Data
Capture” on page 60.

6. Enable Event Bus: On each Processing Server that is submitting sessions for
capture to the Search database, the Tealeaf Event Bus must be enabled,
deployed, and configured to send session attribute information to the
appropriate IBM Tealeaf cxReveal Server.

¢ See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis
Administration Manual.

7. Testing: See “Testing” on page 63.

Get Familiar with the Event Bus

Session attribute data is forwarded from the Canisters to the IBM Tealeaf cxReveal
server using the Tealeaf Event Bus, a component of IBM Tealeaf cxConnect for
Data Analysis.

The Event Bus is used for delivering Tealeaf event information to third-party
consumers of the data. IBM Tealeaf cxReveal utilizes this functionality to capture
additions or changes to session attribute information, which is automatically
tracked in each Canister.

Before you begin, you should familiarize yourself with the Event Bus and how it
works.

Note: After the Tealeaf Event Bus has been enabled and configured on each
Canister, it should function transparently for IBM Tealeaf cxReveal.

See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis Administration
Manual.
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Changing Session Attributes

Through the Event Manager, you can create custom session attributes, which are
user-defined variables that persist with the session data. These variables can be
used to store session data detected by events. Some of these attributes can be
marked for tracking and searching in the IBM Tealeaf cxReveal database.

Through the Event Manager, you can configure up to 64 custom session attributes.
* See "Tealeaf Event Manager" in the IBM Tealeaf Event Manager Manual.
* See "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager Manual.

Any of these attributes may be used as search fields in the IBM Tealeaf cxReveal
database.

Note: Session attributes must be marked for recording the values of them in order
for them to be usable as search fields in IBM Tealeaf cxReveal.

Defining database search fields through session attributes

Note: Changing a search field to a different session attribute changes the available
data and may break existing IBM Tealeaf cxReveal search templates. It is
recommended that you configure these search fields and search templates during
initial implementation and do not change them. See “Behaviors when search fields
are changed” on page 54.

1. From the Portal menu, select Configure > Event Manager.
2. Click the Session Attributes tab.

3. The list of available session attributes is displayed. Session attributes are sorted
by their display Name by default.

¢ To sort the list of session attributes by index number, click the Index column.
To reverse the sort order, click it again.

4. To review the definition of any session attribute, double-click it. The Edit
Session Attribute window is displayed.

* The source of the session attribute data is listed next to Populated By.

¢ In the session attribute definition, you can define whether the session
attribute is tracked or searchable. These settings determine whether the
session attribute is available for use in IBM Tealeaf cxReveal database
searches.

Setting Description

Tracked in cxReveal DB
When this option is selected, the session attribute is tracked in the
IBM Tealeaf cxReveal database. Up to 32 session attributes can be
tracked in the database at any time. When a session attribute is
selected for tracking, data is captured and inserted in to the IBM
Tealeaf cxReveal database. Data is not searchable unless you
configure it to be searchable in the database using the following
setting.

Searchable in cxReveal DB
When this option is selected, the session attribute is searchable in the
IBM Tealeaf cxReveal database using a IBM Tealeaf cxReveal search
template. Up to 5 session attributes can be tracked in the database at
any time. A searchable session attribute must also be tracked. When
a session attribute is selected for searching and tracking, data is
captured and inserted in to the IBM Tealeaf cxReveal database, and
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you may use search templates configured to search for the tracked
attribute to locate sessions from that point onward. See “Configure
cxReveal Search Templates” on page 55.

* See "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager Manual.
5. If you make changes, click Save Draft to save them.
6. To commit any changes made to session attributes, click Save Changes.

See "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager Manual.

Behaviors when search fields are changed

Immediately after the IBM Tealeaf cxReveal database has been installed, you
should configure the session attributes upon which Tealeaf users may search. These
five attributes are the primary search fields used for locating sessions through
session attribute search.

¢ IBM Tealeaf cxReveal checks for changes in these fields once per hour.

However, if you must change the session attributes on which IBM Tealeaf cxReveal
users search, please review the following behaviors.

Suppose you are changing Search Field 5 to search for SessionAttribute20 instead
of SessionAttribute7. The resulting behaviors are as follows:

1. Searches using Search Fields 1 - 4 only are unaffected. You may search for
across all available data using these fields.

2. You may not search for SessionAttribute7 anymore through the Portal.

* The data that has been stored for SessionAttribute7 remains in the database
until a trim operation removes it.

3. You may search for SessionAttribute20 across all available dates. However,
data is populated for this session attribute only from the time when the search
field change was saved and onward.

Note: Although it is possible to search across all dates for SessionAttribute20,
it is important to configure searches for this session attribute only from the
point of change and onward. Searches using this attribute against dates from
before the point of change are executed, even though there is no data available.
Since there are no table indexes available for these searches, they may time out
before sessions can be successfully retrieved.

* For searches specifying an OR operation between search fields including the
changed one or searches that use a not Tike operator on Search Field 5,
searches for sessions before the SessionAttribute20 change may return a
positive number of results.

* For searches specifying an AND operation between search fields including the
changed one, searches for sessions before the point of change fail to return
results from those dates. The exceptions to this failure are if the search uses a
not Tike or not equal operator on Search Field 5; in those two exceptions,
results may be returned.

Suppose that after three days, you choose to switch Search Field 5 back to
SessionAttribute7. The behaviors are as follows:

 Data is available for SessionAttribute20 for the three days that it was assigned
to Search Field 5. However, you cannot search for it anymore.

* Data is available for SessionAttribute7 for all days except the three days, which
are now a gap in the database.
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Testing Configuration in the Portal

This section describes how to test the session attributes.

Searching for session attributes
If your system is already capturing data, you can perform the following steps to
test for the presence and values for each of the above session attributes.

1.
2.
3.

Login to the Tealeaf Portal.
From the Portal menu, select Search > Completed Sessions.

The Portal Search screen is displayed, and the default completed sessions
search template is selected.

* You may also search for session attributes through the IBM Tealeaf CX
RealiTea Viewer.

The available fields may contain entries that correspond to SessionAttribute00
- SessionAttribute04.

* If these search fields are not available, select a different search template for
completed sessions. If you cannot find them in any search template, you may
add a session attribute field to one of your search templates. See
"Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Specify a search:

a. Remove all search fields.

Add one of the above session attributes to the search fields.
Enter a value of *.

Click Search.

If results are returned, then the session attribute is specified and being
captured.

®ao0oo

f. If no results are returned, you may be able to configure the session attribute.
See “Changing Session Attributes” on page 53.

Repeat the above search for each of the session attributes to determine if it is
configured and captured.

Configure cxReveal Search Templates

You can configure your IBM Tealeaf cxReveal search templates to include any of
the five session attributes configured to be searchable.

For more information on configuring session attributes, see “Defining database
search fields through session attributes” on page 53.

If you have configured IBM Tealeaf cxReveal to include Canister data to be
searchable in the database, you may include some Canister session attributes as
search fields in your IBM Tealeaf cxReveal search templates.

— See “Tuning Performance” on page 63.

As needed, you can make changes to the IBM Tealeaf cxReveal templates to use
different fields.

Selecting cxReveal search templates
To select a IBM Tealeaf cxReveal search template to modify, please complete the
following steps.

1.

In the Portal, select Configure > Search Templates. The Configure Search
Templates screen is displayed.
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+ See "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

2. In the Templates panel, select the type of search template to modify. The
available templates for Active, Completed or All Sessions search are displayed.

3. Then, select the IBM Tealeaf cxReveal template. Below, a search template called
cxReveal Active has been selected.

Soarch Templtes | Sasmnnbisl I ETRtiELL

Templates Template Search Fields
-'.,_I.p Active - 3 LoginiD
j= =Dafault Active= b i Sesnabr
L EiRevenl Active Lo Sesnaftr34
E:H-Ei_‘l Compheted P ¢ UszerDefl
BHD) Universal Lo ¢ UserDetd
_Create | | Edit | | copy | | Permissions | | Deletn ||| | searchFields | | AddGrowp | Edit | | Romowe | | save |

Figure 3. Configuring IBM Tealeaf cxReveal Search Templates

4. The list of fields currently in the search template is displayed on the right side
of the screen.

5. You may select any session list template to use with your IBM Tealeaf cxReveal
search template. See “Configure Session List Templates” on page 57.

Creating cxReveal search templates
You can create IBM Tealeaf cxReveal search templates from scratch. When you
create a new one, you must select cxReveal for the template type.

Note: You may only add fields to search templates of IBM Tealeaf cxReveal type
that are session attributes configured to be searchable and trackable.

See "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Editing cxReveal search templates
You may add or remove fields to your IBM Tealeaf cxReveal search templates like
any other search template.

Note: When adding a IBM Tealeaf cxReveal search field to a search template, you
should verify that it is specified with a valid session attribute that is collecting
data. Open the search field definition to verify that the session attribute is not
listed as Unknown Attribute. Such search fields can be added to a search, yet they
return zero sessions every time. Each IBM Tealeaf cxReveal search field should be
verified independent of other IBM Tealeaf cxReveal search fields.
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For more information on making configuration changes to a search template, see
"Configuring Search Templates" in the IBM Tealeaf cxImpact Administration Manual
section.

Configuring the default cxReveal search template

For IBM Tealeaf cxReveal groups, you may configure the default search template to
use. If desired, you may configure the default search template to be one of the
search templates that has been created to query the IBM Tealeaf cxReveal database
for session attribute information.

* IBM Tealeaf cxReveal users may use search templates of IBM Tealeaf cxImpact
type or IBM Tealeaf cxReveal type.

* See "cxReveal User Administration” in the IBM Tealeaf cxReveal Administration
Manual.

Restricting access to cxlmpact search templates

Note: Tealeaf recommends using the Search database for more immediate and
more efficient searches for sessions. Searching for sessions through the Tealeaf
Canisters should be reserved for generalized searches that cannot be easily satisfied
by session attribute search.

As part of your implementation of the session attribute search of the Search
database, you should restrict access for IBM Tealeaf cxReveal users to only use
search templates of IBM Tealeaf cxReveal type. These search templates can only
access the Search database and therefore improve search and retrieval of customer
sessions in the Call Center.

Steps:
To restrict access, please complete the following steps:

1. Login to the Portal as a Tealeaf administrator.

2. From the Portal menu, select Configure > Search Templates.

3. For each Active, Completed, and All Sessions search template, do the following:
a. Select the template. Click Edit.

b. In the Search Type drop-down, check the value. If it is a cxReveal search
template, click Cancel. Skip to the next template.

c. If it is not a IBM Tealeaf cxReveal template, it is a IBM Tealeaf cxImpact
template. IBM Tealeaf cxReveal user groups should not be allowed to use
these search templates. Please do the following:

1) Click Cancel.
2) In the Templates panel, click Permissions.

3) Deselect checkboxes next to the IBM Tealeaf cxReveal user groups. By
default, the Portal is installed with two IBM Tealeaf cxReveal user
groups: cxReveal Admin and cxReveal User.

4) Click Save.
5) Members of the deselected user groups cannot use the search template.
4. Repeat the above steps for each search template.

* See "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Configure Session List Templates

You may also configure session list templates for IBM Tealeaf cxReveal use. A
session list template is used to display search results returned from queries using
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search templates. Since IBM Tealeaf cxReveal search templates access a proprietary
database, they require their own type of search template.

* If IBM Tealeaf cxReveal is configured to include Canister results in search results
returned from the IBM Tealeaf cxReveal database, then any session list template
may be used for search results.

* If IBM Tealeaf cxReveal is configured to omit Canister results, then the session
list template should be configured to include only search fields available in the
IBM Tealeaf cxReveal database.

See “Tuning Performance” on page 63.

In the Portal, select Configure > Search Templates.
Click the Session List Templates tab.
The available session list templates are displayed.

W=

| Seach Templates Session List Templates |

Templates Template Columns

Sample cxReyeal Session List firsi uze

Stanclsrd Template last use

revvenl field 1
reves] field 2
renel field 3
revenl fiekd 4
revasl fiekd 5

| trsate | | Edit | | Copy | | Mssignments _Dsletn ||| | Al Colamas | | Edit | | Remove | save

Figure 4. IBM Tealeaf cxReveal Session List Templates
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See "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Adding or editing a cxReveal session list template

* To edit a IBM Tealeaf cxReveal session list template, select it and click Edit. The
properties of the session list template are displayed. See "Configuring Search
Templates" in the IBM Tealeaf cxImpact Administration Manual.

To add aIBM TealeafcxReveal session list template:
1. In the Session List Templates tab, click Create.
2. The Session List Template properties window is displayed.

3. To configure a IBM Tealeaf cxReveal session list template, select cxReveal from
the Type drop-down.

4. Specify the other properties as needed.

* To enable replay of sessions from the session list template, click the Replay
Sessions checkbox.
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¢ To enable the ability to drill-down on sessions to the list of pages in a
session, click the Pages List Drilldown checkbox.

Note: The ability to Analyze Session Segments and the Server Metrics Table
are not available for IBM Tealeaf cxReveal session list templates.

* See "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

5. To save the template, click Save.

Adding or editing columns of a cxReveal session list template
When a IBM Tealeaf cxReveal template has been created or selected, you may edit
the columns available in the session list template.

To see all possible columns for the IBM Tealeaf cxReveal template, click All
Columns. See “Configuring a cxReveal session list column”

— If IBM Tealeaf cxReveal is configured to include Canister data, then you may
also include Canister fields in your session list template.

— If you add a Canister-based column and IBM Tealeaf cxReveal is not
including Canister data, the column is not populated in the session list.

— See “Tuning Performance” on page 63.

To edit a column, select it in the right panel and click Edit. See “Configuring a
cxReveal session list column.”

To remove a column from the template, select it and click Remove.
To save your changes, click Save.

See "Configuring Search Templates" in the IBM Tealeaf cxImpact Administration
Manual.

Configuring a cxReveal session list column:
To configure a column for a IBM Tealeaf cxReveal session list template, please
complete the following steps.

Note: IBM Tealeaf cxReveal session list templates may include any trackable fields
from the IBM Tealeaf cxReveal database.

1.

Create or select the IBM Tealeaf cxReveal session list to contain the column. See
“Adding or editing a cxReveal session list template” on page 58.

a. To edit one of the columns already in the template, select it in the Template
Columns panel and click Edit.

b. To see all columns that have been created for this type of session list
template, click All Columns. The Configured Session List Template
Columns window is displayed.

1) To edit one of the created columns, select it and click Edit.

2) To create a new column, click New.
The Configure Session List Column window is displayed. Configure the
following properties:
a. From the Type drop-down, select cxReveal.

b. The available fields are updated for IBM Tealeaf cxReveal types of
templates. From the Fields drop-down, select the field to populate the
session list template column. See “Available cxReveal session list template
columns” on page 60.

c. Populate the other fields as needed. See "Configuring Search Templates" in
the IBM Tealeaf cxImpact Administration Manual.

To save the session list template column, click Save.
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4. To add the new column to your session list template, select it in the Configured
Session List Columns window and click Add to Template.

Available cxReveal session list template columns:

Note: If IBM Tealeaf cxReveal is not configured to include Canister data, some
columns that are retrieved from the Canisters are not populated with data in the
session list. See “Tuning Performance” on page 63.

For IBM Tealeaf cxReveal session list templates, the following columns may be
added:

Column Name
Description

Canister Name
Name of the Canister where the original session is stored.

* Active Sessions - STC_<MachineName>_YYYYMMDD

¢ Completed Sessions - LSSN_<MachineName>_YYYYMMDD
where:
<MachineName> corresponds to the name of the machine hosting the
Canister.
<YYYYMMDD> corresponds to the date stamp when the session was
recorded.

Note: The IBM Tealeaf cxReveal database does not contain actual
sessions. It contains references to sessions that may be stored in different
Canisters in the Tealeaf environment.

Canister Server
Server hosting the Canister where the original session is stored.

Note: The IBM Tealeaf cxReveal database does not contain actual sessions.
It contains references to sessions that may be stored in different Canisters
in the Tealeaf environment.

First Use
Timestamp of the first session attribute entry in the IBM Tealeaf cxReveal
database for the listed session

Last Use
Timestamp of the most recent session attribute entry or update in the IBM
Tealeaf cxReveal database for the listed session

Session ID
Internal Canister session identifier

Session List Index
The index of the session in its Canister. This value is not typically of use to
users.

Configure Session Attribute Data Capture

After the session attributes have been specified, you may configure the system to
capture the session attributes and insert them into the IBM Tealeaf cxReveal
database.

Capture of session attributes is managed through the Attribute Indexing session
agent. This session agent must be deployed into a dedicated pipeline on a
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dedicated machine. This machine must be configured to be the recipient of event
data forwarded through the Event Bus of Processing Servers in the Tealeaf
environment.

* Tealeaf supports the deployment of multiple IBM Tealeaf cxReveal Servers to
manage higher volumes of traffic.

Configuration details on the hosting machine and the pipeline are included in the
documentation for the session agent.

* See "Attribute Indexing Session Agent" in the IBM Tealeaf CX Configuration
Manual.

Managing cxReveal Sessions

IBM Tealeaf cxReveal manages sessions independently of IBM Tealeaf cxImpact.
This section describes how the IBM Tealeaf cxReveal capture pipeline and IBM
Tealeaf cxReveal database manage sessions.

Managing session closes

Note: IBM Tealeaf cxReveal assumes that each valid session is closed using a
Session Close event. You should verify that your Tealeaf solution is configured to
use defined Session Close events and to send them to the IBM Tealeaf cxReveal
system through the Tealeaf Event Bus.

* For more information on configure events to close sessions, see "TEM Events
Tab" in the IBM Tealeaf Event Manager Manual.

* See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis
Administration Manual.

After a session has been closed:

* If the Attribute Indexing session agent receives additional hits for the session,
the session agent attempts to update them in the session.

cxReveal session timeouts

By default, IBM Tealeaf cxReveal is configured to timeout sessions if no update has
been made within the last 60 minutes. If one hour has elapsed, the session is timed
out.

Note: Beginning in Release 8.4.1, IBM Tealeaf cxReveal sessions that time out are
not deleted.

In IBM Tealeaf cxReveal, each valid session should be closed by a Session Close
event. If the Session Close event is not seen before the session timeout is triggered,
IBM Tealeaf cxReveal closes the session.

* The timeout setting is specified using the Search Database Session Timeout
(minutes) setting in the Portal Management page. See "cxReveal Settings" in the
IBM Tealeaf cxReveal Administration Manual.

cxReveal search timeouts

When a IBM Tealeaf cxReveal database search is executed, the search is timed out
if results are not returned within 60 seconds, by default. Depending on the
performance of your network and databases, you may wish to adjust this setting.
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* The timeout setting is specified using the Search Database Search Timeout
(seconds) setting in the Portal Management page. See "cxReveal Settings” in the
IBM Tealeaf cxReveal Administration Manual.

Discarding sessions

If the IBM Tealeaf cxReveal pipeline receives a Session Discard event from the
Tealeaf Event Bus, the session is deleted and removed from the database.

Note: The IBM Tealeaf cxReveal pipeline and Attribute Indexing session agent
must receive a Session Discard event in order to discard a session.

The configured event must be marked for delivery to the Event Bus. If no Session
Discard event is sent, the session is not discarded until after it has timed out.
During the interval, other actions may occur to alter the session data in the IBM
Tealeaf cxReveal database. For more information on sending events to the Event
Bus, see "TEM Events Tab" in the IBM Tealeaf Event Manager Manual.

Through the Event Bus, these events are inserted in the [CEP] section of the
request with the following information:

DiscardedSession=true

See "Tealeaf Event Bus" in the IBM Tealeaf cxConnect for Data Analysis Administration
Manual.

cxReveal pipeline shutdown

If the IBM Tealeaf cxReveal pipeline or its Attribute Indexing session agent shuts
down or crashes, when the system restarts, all open sessions with a last timestamp
past timeout are deleted immediately or upon the following hour's check.

* This deletion happens regardless of whether during the downtime an actual
Closed event was received.

* Open sessions that have not timed out yet are processed as normal as more hits
come in.

Session removal

Sessions are retained in individual tables for each day. A day's session data is

retained in the database for 30 days, after which the data is deleted.

* This length of time is defined by the parameter Search Database Session
Attribute Tables - Days Retain. See "cxReveal Settings" in the IBM Tealeaf
cxReveal Administration Manual.

Logging

Logging of IBM Tealeaf cxReveal database searches can be enabled through the
Portal Management page, where you may also configure the number of days to
retain logs.

* Search Database Log - Days Retain
* Log Search Database Searches
* See "cxReveal Settings" in the IBM Tealeaf cxReveal Administration Manual.

Logs are available for download from each IBM Tealeaf cxReveal server through
the Portal Management page.
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¢ See "Managing Tealeaf Servers" in the IBM Tealeaf cxImpact Administration
Manual.

Statistics

Statistics are tabulated for the IBM Tealeaf cxReveal search database and reported
in the Portal.

* See "System Status" in the IBM Tealeaf cxImpact Administration Manual.
¢ See "System Status" in the IBM Tealeaf cxImpact Administration Manual.

Testing

After you have configured the session agent, pipeline, and Portal objects, you may
test the capture and database population of session attributes by performing a
search of them.

* See "Attribute Indexing Session Agent" in the IBM Tealeaf CX Configuration
Manual section.

Troubleshooting

For more information on troubleshooting, see "Troubleshooting - cxReveal" in the
IBM Tealeaf Troubleshooting Guide.

Tuning Performance

By default, when matches are found for session attribute searches, the Portal also
queries the Canisters where the matching sessions are stored for additional session
information. This information includes the list of events, browser information,
domain location, and other useful information about the visitor and the session.

Depending on the number of users in your environment and other performance
factors, this additional querying of the Canister may significantly impact
performance of session search and session retrieval.

Note: For optimal search performance, specify a narrow date range when defining
your search terms.

Optionally, you may disable this additional querying of the Canisters. When
disabled, the returned search results contain only the information that's stored in
the IBM Tealeaf cxReveal database. These fields include the available columns for
IBM Tealeaf cxReveal search templates, as well as sufficient information to locate
and replay the session stored in the Canister.

* For more information on the IBM Tealeaf cxReveal search template columns, see
“Available cxReveal session list template columns” on page 60.

Note: If you disable querying of the Canisters and your IBM Tealeaf cxReveal
session list templates are configured to display some Canister information, those
columns in the displayed list are blank. See “Configure Session List Templates” on
page 57.

The setting to disable is Use Canister Data for Database Search Results. For

more information on disabling querying of the Canisters, see "cxReveal Settings" in
the IBM Tealeaf cxReveal Administration Manual.
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Diagnostics Resources

You can use the following Portal resources to review status and health information
on the IBM Tealeaf cxReveal session agent, pipeline, and database.

Feature
Description

Portal Application Information Report
Review build number and current size and allocation of IBM Tealeaf
cxReveal database.

* See "Portal Application Information Report" in the IBM Tealeaf cxImpact
Administration Manual.

DecoupleEx Status Report
Review health and status data on the IBM Tealeaf cxReveal Server.

* See "System Status" in the IBM Tealeaf cxImpact Administration Manual.

Database Filegroup Size Report
Review more detailed information on the size of filegroups in the
TL_SEARCH database.

* See "System Status" in the IBM Tealeaf cxImpact Administration Manual.

Portal Management page
Review configuration information for Search Server embedded in IBM
Tealeaf cxReveal Server. Execute commands and acquire logs from the
server.

* See "Managing Tealeaf Servers" in the IBM Tealeaf cxImpact Administration
Manual.

Attribute Indexing Session Agent

64

The Attribute Indexing session agent can be deployed to retrieve session attribute
information from Tealeaf event data and to insert that content into the IBM Tealeaf
cxReveal database (TL_SEARCH).

* This session agent is deployed in a Windows pipeline that receives event data
through the Tealeaf Event Bus enabled and configured on each Processing Server
in the environment.

Note: The Tealeaf Event Bus is a component of cxConnect for Data Analysis, a
separately licensable component of the Tealeaf CX platform. please contact your
IBM Tealeaf representative.

Available through IBM Tealeaf cxReveal, the IBM Tealeaf cxReveal database enables
Tealeaf users to quickly locate Tealeaf sessions in any state of capture and
processing by searching for session attributes. Session attributes may be specified
as soon as the first hit is evaluated in the Windows pipeline. For example, the
value for the login identifier is typically set to populate the SessionAttribute00
attribute as soon as the visitor logs into the web application. When the first session
attribute is detected by the session agent, a new record for the session is inserted
into the IBM Tealeaf cxReveal database.

Note: The cxReveal database is a component of cxReveal, a separately licensable
component of the Tealeaf CX platform. please contact your IBM Tealeaf
representative.
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This database record can be immediately queried and retrieved through Portal
search by IBM Tealeaf cxReveal users, which enables them to quickly locate visitor
sessions as needed.

* Since these visitor records are stored in a single SQL Server database, search and
retrieval of visitor information is very fast.

* For more information on searching by session attribute, see "cxReveal -
Searching Sessions by Session Attribute" in the IBM Tealeaf cxReveal User Manual.

Note: The deployment of multiple IBM Tealeaf cxReveal servers is supported for
higher volume web applications.

Pre-Requisites

Note: This section describes how to configure the IBM Tealeaf cxReveal server and
pipeline for capture of session attributes. To enable the end-to-end solution for
session attribute capture, search, and replay, additional configuration is required in
the Portal. Before you begin, you should review the other configuration steps. See
"Configuring Session Attribute Search" in the IBM Tealeaf cxReveal Administration
Manual.

1. IBM Tealeaf cxImpact: The attribute indexing session agent is available
through IBM Tealeaf cxImpact.

2. IBM Tealeaf cxConnect for Data Analysis: The capture of session attribute
information from each Canister requires the use of the Tealeaf Event Bus to
send events to the designated pipeline for capture. See "Tealeaf Event Bus" in
the IBM Tealeaf cxConnect for Data Analysis Administration Manual.

3. IBM Tealeaf cxReveal: The IBM Tealeaf cxReveal database is a component of
IBM Tealeaf cxReveal, a separately licensable product of the IBM Tealeaf CX
system.

 IBM Tealeaf cxReveal requires a separate installation on each IBM Tealeaf
cxReveal server. See "cxReveal Installation” in the IBM Tealeaf cxReveal
Administration Manual.

* Enabling session attribute search requires additional configuration. See
"Configuring Session Attribute Search" in the IBM Tealeaf cxReveal
Administration Manual.

Note: The Attribute Indexing session agent should not be deployed in a Windows
pipeline where other processing occurs. This session agent requires a dedicated
Windows pipeline and a separate IBM Tealeaf cxReveal server.

Installing cxReveal

Before you begin, the Tealeaf Transport Service and the IBM Tealeaf cxReveal
database must be installed on each IBM Tealeaf cxReveal server. See "cxReveal
Installation" in the IBM Tealeaf cxReveal Administration Manual.

The IBM Tealeaf cxReveal database may be installed separately on the same system
using the Tealeaf Database Manager.

¢ See "Using Tealeaf Database Manager" in the IBM Tealeaf Databases Guide.
* See "cxReveal Database" in the IBM Tealeaf Databases Guide.
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Configuration Workflow

The basic architecture for attribute indexing pipelines is to split content from one
of your existing Windows pipelines and to send the content to a Windows pipeline
on the IBM Tealeaf cxReveal Server for insertion of session attribute information
into the IBM Tealeaf cxReveal database.

1. If you have not done so already, you must install the Processing Server and
IBM Tealeaf cxReveal database on each dedicated IBM Tealeaf cxReveal Server.
Multiple deployment models are supported for the IBM TealeafcxReveal
database. See "cxReveal Installation” in the IBM Tealeaf cxReveal Administration
Manual.

2. As part of the install process, a default pipeline is created. It contains the
minimum session agents to capture and insert session attribute information into
the database, including the Attribute Indexing session agent.

* For more information on configuring pipelines, see "TMS Pipeline Editor" in
the IBM Tealeaf cxImpact Administration Manual.

¢ See “Attribute Indexing processing pipeline.”

3. Configure the parameters of the Attribute Indexing session agent. See
“Configuring Attribute Indexing Session Agent” on page 68.

4. In the main Windows pipelines that are sending hits through the Event Bus to
the Processing Server managing attribute indexing, enable the Event Bus and
configure the Event Bus. See “Configuring the Event Bus” on page 67.

5. After the Event Bus has been enabled and tested locally, the Event Bus pipeline
must be configured to send Tealeaf events to the destination system. See
“Minimum Event Bus Pipeline” on page 67.

6. Repeat the Event Bus configuration for each Processing Server to send events to
the IBM Tealeaf cxReveal Servers.

7. After you have completed the configuration steps, you may test capture as
soon as data has arrived at the pipeline. See “Testing Capture of Attributes” on
page 71.

Attribute Indexing processing pipeline

In the following sections, you can review the minimum pipeline configuration
required to enable capture of session attributes. These are minimum requirements.
The pipeline required for your Tealeaf environment may vary.

Note: The IBM Tealeaf cxReveal Installer configures the following default pipeline
for use. If this pipeline meets your needs, additional configuration may not be
required. You may wish to review the available parameters for the session agent.
See “Configuring Attribute Indexing Session Agent” on page 68.

The pipeline that is used to capture session attributes and insert them into the IBM
Tealeaf cxReveal database requires the following minimum configuration:

DataDrop > DecoupleEx > SessionRouter > AttrIndexer > Null

Tealeaf recommends using the DecoupleEx pipeline session agent. DecoupleEx
enables spooling of hits into the pipeline during overloaded conditions, such as
when a broad search is being executed. When the DecoupleEx session agent is
deployed, statistical information on the pipeline performance can be surfaced in
the Portal. See "System Status” in the IBM Tealeaf cxImpact Administration Manual.

Avoid using Decouple in the IBM TealeafcxReveal Search pipeline. See "Extended
Decoupler Session Agent" in the IBM Tealeaf CX Configuration Manual.
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Note: The Attribute Indexing session agent must be configured so that its
downstream session agent is the Null session agent. See “Configuring Attribute
Indexing Session Agent” on page 68.

Note: In almost all environments, Tealeaf Privacy rules are not necessary for this
pipeline, as the terminating session agent is the Null session agent. If privacy is
required to meet your security requirements, you may insert the Privacy session
agent or Extended Privacy session agent after the Decouple session agent in the
above pipeline.

* See "Privacy Session Agent" in the IBM Tealeaf CX Configuration Manual.

* See "Extended Privacy Session Agent" in the IBM Tealeaf CX Configuration
Manual.

For more information on configuring Windows pipelines, see "TMS Pipeline
Editor" in the IBM Tealeaf cxImpact Administration Manual.

Adding the Session Agent
Session agents can be added through the Pipeline Editor in TMS. For more
information, see:

* "Adding a Session Agent" in the IBM Tealeaf CX Configuration Manual
+ "Tealeaf Management System" in the IBM Tealeaf cxImpact Administration Manual

Configuring the Event Bus

The Tealeaf Event Bus enables the delivery of Tealeaf events to other systems or
pipelines for offline analysis or use.

Note: The Tealeaf Event Bus is a component of cxConnect for Data Analysis, a
separately licensable component of the Tealeaf CX platform. please contact your
IBM Tealeaf representative.

Before you deploy the session agent, you should complete the following
configuration tasks on each Processing Server in the environment sending event
data for capture by the session agent:

1. Enable the Event Bus.

Note: When enabling the Event Bus, do not include the response data. Since
the Attribute Indexing session agent collects session-level information only,
including individual response data consumes unnecessary bandwidth to
transfer to the IBM Tealeaf cxReveal server.

2. Enable the Event Bus pipeline local to the Processing Server hosting it.
3. Configure the Event Bus pipeline.

4. Test the Event Bus pipeline by writing event data to a Tealeaf archive.

These steps are documented in the Event Bus documentation. See "Tealeaf Event
Bus" in the IBM Tealeaf cxConnect for Data Analysis Administration Manual.

Minimum Event Bus Pipeline

After the Event Bus has been enabled, configured, and tested on each Processing
Server submitting event data for capture, you can configure the Event Bus
pipelines to forward data to the machine dedicated to capturing session attribute
data.

1. From the Portal menu, select Tealeaf > TMS.
2. Click the WorldView tab.
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3. From the Server drop-down, select one of the Processing Servers sending data
to the session attribute machine.

4. Click the Canister node.
5. Click Event Bus configuration. In the Config Actions pane, click View/Edit.

6. The Event Bus pipeline is displayed in the Pipeline Editor. See "TMS Pipeline
Editor" in the IBM Tealeaf cxImpact Administration Manual.

7. During testing, you may have deployed one of the following session agents as
the last one in the pipeline (the terminal session agent).

* "Null Session Agent" in the IBM Tealeaf CX Configuration Manual
e "Archive Session Agent" in the IBM Tealeaf CX Configuration Manual

8. When you are ready to send data to the session attribute capture machine,
replace the terminal session agent with the Socket session agent.

9. Drag and drop the terminal session agent in the pipeline to the Available
Session Agents pane.

10. Drag and drop the Socket session agent from the Available Session Agents
pane to be the last session agent in the pipeline.

11. The pipeline should look something like the following:
Decouple > <other_agents> > Socket

where:
<other_agents> - may be zero or more session agents, depending on your
Event Bus requirements.

12. Configure the Socket session agent. See “Configuring the Socket Session
Agent.”

13. Save your changes.
14. Push the changes to other servers.

15. Repeat these configuration changes to each Event Bus on the Processing
Servers in your environment.

Configuring the Socket Session Agent

This session agent terminates all Event Bus pipelines that send event data for
further processing by another pipeline. The following settings need to be
configured for the Event Bus pipeline for each Processing Server delivering events.
See "TMS Pipeline Editor" in the IBM Tealeaf cxImpact Administration Manual.

Setting Description

Port  Set this value to the port used by the pipeline that is capturing attribute
information on the IBM Tealeaf cxReveal server.

Server Set this value to the hostname of the IBM Tealeaf cxReveal server.

See "Socket Session Agent" in the IBM Tealeaf CX Configuration Manual.

Configuring Attribute Indexing Session Agent

After you have configured the pipeline to capture session attribute information,
you must configure the Attribute Indexing session agent in the pipeline.

This session agent scans content for user-defined session attributes. When new
attribute values or changes to attribute values are detected, the session agent uses
the available session information to attempt to locate the session record in the IBM
Tealeaf cxReveal database.

¢ If there is no match with an existing record, a new session record is inserted into
the database.
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Settings
When the Windows pipeline is installed, the session agent configuration items are
specified for you.

Note: Do not change values for the available configuration settings other than the
settings listed below.

Setting Description

LogLevel
Set the log level for the session agent. See “Logging.”

RolloverHour
Define the hour when a new database table is created to store the captured
session attributes for the day.

MasterPipeline
One pipeline must be configured as the master pipeline for maintenance
purposes. If you are using only one pipeline to capture session attributes,
set this value to true.

For more information on configuring these settings, see "TMS Pipeline Editor" in
the IBM Tealeaf cxImpact Administration Manual.

Logging
The Attribute Indexing session agent can be configured to generate logging
information.

To enable logging:

1. In the Attribute Indexing session agent, you must configure the LogLevel value
to one of the following values:

* status

* info

* warn

* error (default)
* debug

Note: Use the debug level only for troubleshooting specific issues. When the
issue has been resolved, reset to a lower level.

2. Save changes.
Log files are written to the main Tealeaf log directory.

The following log is written from the session agent.

<Tealeaf_install_directory>\Logs\
TLSessionAgentAttrIndex_Pipelineld_YYYYMMDD.log

where:

e Pipelineld - identifies the port number for the pipeline. Typically, this value is
1966 or 1967.

* YYYYDDMM - date stamp
This log receives status information from the session agent once per minute.

<Tealeaf install_directory>\Logs\
RevealStatus_YYYYMMDD.1og
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where:
* YYYYDDMM - date stamp

Log fields: The following fields are displayed in the RevealStatus log file, which
are updated once per minute.

* Log files are updated from the master pipeline only on each IBM Tealeaf
cxReveal server.

Field(s)
Description

RevealStatus
Current status of the connection to the IBM Tealeaf cxReveal database (up
or down)

RevealDownReason
If status is down, this field indicates the reason.

SessionsUpdated
Number of Tealeaf sessions that were updated in the past minute with new
or changed session attributes.

HitsSkippedAttributesUnchanged
Number of hits that were skipped in the past minute because there were
no new or updated session attributes.

SearchAttributel -
SearchAttribute5
The session attributes that are currently configured to be searchable.

* IBM Tealeaf cxReveal supports up to five searchable session attributes.
The attributes available for IBM Tealeaf cxReveal search are defined
through the Event Manager. See "TEM Session Attributes Tab" in the
IBM Tealeaf Event Manager Manual.

TrackedAttributel -
TrackedAttribute32
The session attributes that are currently configured to be tracked.

* IBM Tealeaf cxReveal supports tracking in the database of up to 32
session attributes. The attributes available for IBM Tealeaf cxReveal
tracking are defined through the Event Manager. See "TEM Session
Attributes Tab" in the IBM Tealeaf Event Manager Manual.

Downloading logs:
Log files may be downloaded through the Portal Management page.

1. In the Portal menu, select Tealeaf > Portal Management.
2. Click the Manage Servers link.

3. Select the server hosting the Attribute Indexing session agent and IBM Tealeaf
cxReveal capture pipeline.

4. Click the Tealeaf Logs icon in the toolbar.
5. In the Filter By drop-down, select SA Session Attribute. Click Refresh.

6. Click the link of the log file you wish to download. Log filenames should be in
the following format:

TLSessionAgentAttrIndex_YYYYMMDD.1og

See "Managing Tealeaf Servers" in the IBM Tealeaf cxImpact Administration
Manual.
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Testing Capture of Attributes

This section describes how to test the capturing of session attributes.

Check the Pipeline
Through TMS, you can verify that the pipeline is operating in the Pipeline Status
tab.

1. From the Portal menu, select Tealeaf > TMS.
2. Click the Pipeline Status tab.

3. From the Server menu, select the server where the session attributes are
evaluated.

4. Verify that the proper pipeline is selected in the Pipelines panel.

5. In the upper-right pane, you can review the character and hit counts passed
through each session agent.

* Non-zero values indicate that the pipeline is capturing content.

* See "TMS Pipeline Status Tab" in the IBM Tealeaf cxImpact Administration
Manual.

Verify Search
The best way to test capture of session attributes is to perform a search through
the Portal using the IBM Tealeaf cxReveal template for Active sessions.

Note: To enable search, additional configuration is required. See "Configuring
Session Attribute Search" in the IBM Tealeaf cxReveal Administration Manual.

* If sessions are returned, then the session agent is capturing session attributes
and creating valid records in the IBM Tealeaf cxReveal database.

* See "cxReveal - Searching Sessions by Session Attribute" in the IBM Tealeaf
cxReveal User Manual.

Tealeaf Session Agents

* "Adding a Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Archive Session Agent" in the IBM Tealeaf CX Configuration Manual

* Attribute Indexing Session Agent

 "Canister Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Cookie Parser Session Agent" in the IBM Tealeaf CX Configuration Manual

¢ "Data Drop Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Data Parser Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Decouple Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Extended Decoupler Session Agent" in the IBM Tealeaf CX Configuration Manual
* "Extended Privacy Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Health-Based Routing (HBR) Session Agent" in the IBM Tealeaf CX Configuration
Manual

* "Inflate Session Agent" in the IBM Tealeaf CX Configuration Manual

* "JSON Mobile Parser Session Agent" in the IBM Tealeaf CX Configuration Manual
* "Managed Code Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Null Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Privacy Session Agent" in the IBM Tealeaf CX Configuration Manual

¢ "Real-Time Monitoring and Alert (RTA) Session Agent" in the IBM Tealeaf CX
Configuration Manual
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* "Response Tags to Request Session Agent" in the IBM Tealeaf CX Configuration
Manual

* "RTA Split Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Sessioning Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Session Router Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Socket Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Statistics Logger Session Agent" in the IBM Tealeaf CX Configuration Manual

* "Tealeaf Reference Session Agent" in the IBM Tealeaf CX Configuration Manual
+ "Tealeaf Sessioning Session Agent" in the IBM Tealeaf CX Configuration Manual
* "TimeGrades Session Agent" in the IBM Tealeaf CX Configquration Manual

* "TLI Session Agent" in the IBM Tealeaf CX Confiquration Manual

* "URL Decode Session Agent" in the IBM Tealeaf CX Configuration Manual

Configuring Search Templates

72

Through the Portal, you can define search templates and session list templates.

* Search templates specify the set of fields and default properties that are
available to users when the search template is selected. See “Search Templates.”

* Session list templates are lists of attribute columns used on the session list grid
for search results. See “Session List Templates” on page 86.

To define search templates, select Configure > Search Templates in the Portal
menu.

For more information about configuring search templates, see "Configuring a
Search Template" in IBM Tealeaf cxReveal Administration Manual.

Search Templates

A search template defines the scope of the criteria that can be used to search and
are an effective means of limiting for users and groups the searchable fields that
they can search.

By developing and deploying well-designed templates, the Tealeaf administrator
can focus searches on the terms of interest to specific groups, prevent access to
sensitive fields, and limit the number of returned results for better search
performance.

* Search templates are available for selection in the session search and visitor
search pages.

— See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.
— See "Searching for Visitors" in the IBM Tealeaf cxResults User Manual.
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Figure 5. Search Templates

Search templates control the fields that are available for a user to use in a search,
as well as the default attributes of the search such as date range and servers to
search. On the Search Templates pane of the Search Template Configuration page,
there is a list of defined templates, categorized by search type. The three search
types correspond to a set of searchable sessions:

* Active searches the currently active sessions.
* Completed searches completed and indexed sessions

e All Sessions searches across both active and completed sessions.

As the templates are incompatible across search types, each template has a list of
search fields available to it.

Configuring a Search Template

Note: After you have created a new search template, you should immediately set
the permissions to enable viewing of it. Otherwise, it does not appear among your
available search templates. To edit permissions, select the template and click
Permissions. See “Permissions” on page 76.
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Template Properties
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Figure 6. Template Properties

The available properties for a search template are listed below. Each property on
the template is a default setting, which the user may alter at the time of the search,
if enabled by permissions:

Property
Description

Name  The name of the template.

Search Type
The type of sessions that can be searched using the template: Active,
Completed, or AT1 Sessions.

Date Span
The date range over which the search template covers.

Scope How selected fields are applied to the search:

* AND - Same Session - The search returns sessions that match all
specified fields.
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* AND - Same Page - The search returns sessions that have individual
pages matching all fields.

* OR - Any Session - The search returns sessions that match any of the
fields.

Sort By
How the matching sessions are sorted.

Timeout
The maximum amount of time allotted for the search.

Auto Stop
The search automatically stops after opening the number of sessions
defined by this property.

Session List Template
The Session List template in which to display the results returned when a
search is executed with this search template. See “Session List Templates”
on page 86.

Search Servers
The search servers to select for searching by default.

Notes If specified, the notes appear as an informational textbox above the search
fields on the search page.

+ To insert a newline in the Notes® textbox, enter \n. These text strings
appear as-is in the Notes textbox. You can press ENTER in the textbox to
make the notes more legible.

Copying Templates
You can copy a search template and modify it to create your own search template.
To copy a template, click Copy beneath the list of templates.

If the Duplicate Search Fields option is selected, new copies of the search fields are
created with the new search template. Otherwise, the new template uses the same
fields as the original. Because search fields and templates are independent,
multiple templates can use the same search field.
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Permissions
You can specify the user groups that can access the selected template for searches.

Search Template Permissions

Yisible To These User Groups:

¥ admin Group
¥ Public

v Super User
¥ Portal User
¥ Reveal User
[T Event Admin

e i

Figure 7. Search Template Permissions

Deleting Templates
To delete a template to which you have access, click Delete. Any search fields used
by the template are not deleted.

Template Search Fields

Search fields are defined in a search and populated with values to generate a
specific search query. Individual search fields can be configured and assigned to
search templates

To add a new search field group, click Add Group. Enter a name and select
Add. In the Search Template Fields panel, a new folder appears with the group
name as its label.

To edit a template search field, select it and click Edit. See “Search field
properties” on page 82.

Search fields may be labeled as Available, Active, or Required. For more
information, please review the Search Field Modes panel.

To change the mode for a search field, click the icon next to it and select the new
mode. See “Search Field Modes” on page 84.

Note: A search template can display up to six recommended or required fields.
These fields appear when the template is first loaded. If additional
recommended or required fields are specified in the template, only the first six
such fields are displayed when the template is initially displayed to the user.

To remove a field, select it and click Remove.

To save the search template, click Save.

Configuring a Search Field
To add a search field to the template, click Search Fields in the Template Search
Fields pane to display the currently available search fields:
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Note: If a field does not appear in the list, it may be incompatible with the current template and is therefore hidden.
Incompatible fields use search keywords that cannot be used with the current template. To display all fields, select
the Show Incompatible Fields checkbox. Incompatible fields cannot be added to the current template.

Configured Search Fields

Target Group: Session Info ;l

I Show Incompatible Fields

All Text -
Annotation Authors
Annotations
Browser Type
Zancelled Pages
Client IP

Ciomain

Event Walues
Events

First Page

Form Field

Gh Campaign

S8 Content

G kKeyword

GA Medium

G40 Repeat Visitor
Gh Source

GhA Urchin Visitor ID
Hit Count e

" Add To Templail:e

Figure 8. Configured Search Fields

* To add a field to a field group, select the group from the Target Group
drop-down.

* To add a field to the current search template, select it and click Add To
Template.

* To edit a search field, click the Edit icon. See “Search field properties” on page
82.

* To create a new search field, click the + icon. See “Creating a New Search Field”
on page 81.

Available Search Fields
The following search fields are available in the default templates for Active and
Completed sessions.
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Note: Depending on the type of search template, some search fields may not be
available. For All Sessions search templates, you may add search fields only if they
are applicable to both active and completed search templates.

Note: Fields that have been encrypted using privacy rules in the IBM Tealeaf CX
Passive Capture Application or Windows pipelines cannot be decrypted in the
Portal.

* These encrypted fields can be decrypted only during replay.

* As an alternative, you can leave the configured fields in unencrypted state in the
session data and then define privacy rules specifically to be applied during
session replay, permitting the display of the unencrypted data in the Portal, as
needed. See "On-Demand Privacy" in the IBM Tealeaf CX Configuration Manual.

Text:

For completed sessions, you can search for text strings contained in requests,
responses, and other derived data. The text strings can include different search
patterns to further restrict the search.

Note: Free text searches can be expensive to complete. These search fields should
be included only where other indexed search field options are not available.

Text String Type
Description

ATl Text
When searching completed sessions, you can search for a text string in any
part of the session data, including the request, the response, and any
derived data such as events or custom user-defined fields. This data is
indexed using the dtSearch software program, so any of the search options
provided by dtSearch are available. The following patterns are supported:
¢ * Wild character. For example, C+* matches both CC and CAT.
* { } Matches any character contained within the bracket.

* " Represents the beginning of the line. For example, ~T searches for any
line starting with a T.

* $§ Represents the end of the line. For example, error$ returns any line
ending with error.

* \ indicates to emphasize the subsequent character in the search.

Text in Request
You can search for a text string in the request portion of a hit in completed
sessions. The above patterns are supported.

Text in Response
You can search for a text string in the response portion of a hit in
completed sessions. The above patterns are supported.

Events:

During processing of sessions, Tealeaf events are triggered based on visitor session
data. The data derived from events is stored with the actual hit and session
information and may be searched like captured data.

e With IBM Tealeaf cxResults, these events are also stored in the Visitor database
where they can be searched for dates beyond the life of the replayable sessions.
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Event Selector
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Figure 9. Event Selector

Events may be associated with one or more dimensions, which enable the
reporting of event data across multiple axes.

* See "Tealeaf Data Model" in the IBM Tealeaf Reporting Guide.
 Users of the search template may select the dimension or dimensions associated

with the event to search as part of the query. See "Searching Session Data" in the
IBM Tealeaf cxImpact User Manual.

* Dimensions are created in the Tealeaf Event Manager. See "TEM Dimensions
Tab" in the IBM Tealeaf Event Manager Manual.

Input Type for events

Search fields for events may be configured to use one of the following input types:

Input Types
Description

Event Selector

Template user may select any accessible event.

Pulldown

Template user may select an event from a pulldown menu that you
populate. You may also specify default values.

Radio buttons

Template user may select an event by clicking a radio button from a set
that you define. You may also specify default values.
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Event Values:

You may specify fields that enable search for specific event values. Users may
select the event and value for which to search or use the default ones you specify.

Configure Search Field

Title:
Input Type:

keyword:

Event Yalues

Event Value Selectar ;l

Default Event: Fizxed - Operating System

Event Values ;l

Default Yalue: WinxP

e [t

Figure 10. Configuring Event Value Search Field

Field Description

Default Event
Click the link to select the event to use as the default event for this search
field.

Default Value
Enter the default value with which to populate the search term. No data
validation of the default value is performed.

Event values may be specified using different kinds of input types. See “Input
Type for events” on page 79.

Values for events are stored in a data entity called a fact in the request buffer.

* For more information on session attributes, see "RealiTea Viewer - Request View"
in the IBM Tealeaf RealiTea Viewer User Manual.

Session Info:

As Tealeaf builds and processes sessions, it derives data from the captured
information that is applicable to the entire session.

For more information on the default fields provided in active and standard search
templates, see "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Page Info:

As Tealeaf creates and processes hits, it derives data from the captured information
that applies to the entire hit or page.
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* For this grouping, the list of searchable fields for active sessions is completely
different from completed sessions.

* The active page fields are aggregated into reports contained within dashboards.

For more information on the default fields provided in active and standard search
templates, see "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

cxReveal Fields:

Tealeaf enables IBM Tealeaf cxReveal users to search for sessions by session
attribute. These session attributes are stored in a separate high-performance
database, where they are accessible for search as soon as they are identified in the
session data.

Note: Searching for session attributes is a component of cxReveal, a separately
licensable component of the Tealeaf CX platform. please contact your IBM Tealeaf
representative.

When configuring search templates of IBM Tealeaf cxReveal type, you may select
from the available session attributes that have been marked to be searchable and
tracked in the IBM Tealeaf cxReveal database.

Note: When adding a IBM Tealeaf cxReveal search field to a search template, you
should verify that it is specified with a valid session attribute that is collecting
data. Open the search field definition to verify that the session attribute is not
listed as Unknown Attribute. Such search fields can be added to a search, yet they
return zero sessions every time. Each IBM Tealeaf cxReveal search field should be
verified independent of other IBM Tealeaf cxReveal search fields.

* You may define the session attributes that are marked for searching and tracking
in the database in the Event Manager. See "TEM Session Attributes Tab" in the
IBM Tealeaf Event Manager Manual.

Note: These search keywords are compatible with the IBM Tealeaf cxReveal Active,
Completed, and All Sessions search templates only, as these templates perform
queries of the IBM Tealeaf cxReveal database.

* These search template fields cannot be used in IBM Tealeaf cxImpact search
templates.

* See "Configuring Session Attribute Search" in the IBM Tealeaf cxReveal
Administration Manual.

Creating a New Search Field
To create a new search field, click + in the Configured Search Fields dialog.
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Search field properties:

Creating or editing a search field opens the Configure Search Field dialog;:

Configure Search Field

Title:
Input Type:

Kewword:

MOS Hashing:

Default Yalue:

Mew Search Field

Free Text ;l
Al Text -]
Disahled -]
localhost

=

Figure 11. Configure Search Field

You can modify the following properties for your new or edited search field:

Property
Description

Title The title of the search field.

Input Type
The types of input the search field can use. This value affects how the
search field is displayed and the users who are allowed to use it.

¢ Free Text - The user is presented with a textbox and can freely enter
text. The textbox is populated with the contents of the Default Value
property.

¢ Pulldown - The user is presented with a drop-down of specified values
from which to select. The default selected item is specified by the
Default Value property. The items in the drop-down are controlled by
the Values property.

— You can specify empty values, if desired. If the user selects the label
corresponding to an empty value, the field is not submitted as part of
the search.

* Radio Button - The user is presented with a list of radio buttons of
specified values from which to select. The default selected item is
specified by the Default Value property. The items in the drop-down are
controlled by the Values property.

— You can specify empty values, if desired. If the user selects the label
corresponding to an empty value, the field is not submitted as part of
the search.

* Prebuilt Query - You can enter a pre-configured query in one of the
following textboxes:
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— Query - If the search field is selected to be included in the search by a
user of the template, this query is used in the search.

— Inverse - If the search field is selected to be not included in the
search by a user of the template, this query is used in the search. If
this query is not specified and the user selects not included, a
negated version of the Query value is used.

* Form Field Input - This value is only used with the Form Field
keyword. When it is used, the user is presented with two textboxes: one
for a field and one for a value. The textboxes are populated with the
values of the Field and Value properties, respectively.

— Hide Field Input - If this is enabled, the field input for a form field
is hidden, and the default is used. This feature can be used to restrict
a form field search to a specific field and to permit only an input for
the value.

* Event Selector - This Input Type value is only used with the Events
keyword. When it is used, it provides the user with the Event Selector
popup when the field is selected.

Keyword
The actual search keyword to use when this field is selected. See “Selecting
keywords.”

MD5 Hashing
For search fields that match against text, this option hashes the value the
user inputs before generating the query. This feature allows a user to enter
plain text to match against an indexed field that has been MD5 hashed to
clean or obfuscate data.

Default Value
The default value to use when the search field is selected. This value
changes depending on the Input Type.
* For event and event value fields, you may select the default event for
the field.

Values
When the Pulldown and Radio Button Input Types are selected, the Values
property is enabled and contains a list of the displayed values from which
the user can choose.

* To add a value, click Add.
* To edit a value, click Edit.

* To remove a value, click Remove. You can reorder values by using the
Up and Down buttons.

* Label - The visible text for this option.

¢ Value - The actual value for the option that is used to generate the
search query.

* Events - Displays the Event Selector to populate the Label and Value
with an event.

Selecting keywords:
The available items correspond to search keywords used when building the actual

query. For example Event corresponds to t1tstsuniqueid in Completed Search
Templates.
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current search template.

Some keywords are not compatible with the current template type. When you
select an incompatible keyword, the Keyword: marker indicates that there is an
issue. Mouse over the Question Mark (?) icon to review the issue, as indicated
below:

T A -
£

Keyword: @ |all Text

Figure 12. Issue with Keyword
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If you have an incompatible keyword, you cannot save the search field until the
issue is corrected.

Selecting the following keywords populates special items in the Input Type list:

Keyword
Input Type item

Event Event selector

Form Field
Form Field Input (two text inputs, form field and value)

AppData
AppData Input (same as form field input)

See "Search Keywords" in the IBM Tealeaf cxImpact User Manual.
Search Field Modes

A search field added to a template has a mode: Available, Recommended, and
Required.

e To select the mode for a field, click the icon next to the search field.
Mode Description

Available
The field is not displayed but can be used in a search. This is the default
mode of a search field that is added to a template.

Active The field is displayed and populated with a pre-configured default value.
An active field can be removed from a search. An empty active field will
not be included in a search.

Required
The field is displayed and populated with a pre-configured default value.
A required field cannot be removed from a search. A required field must
contain a value or valid selection when the search is performed.

Adding Session Attributes
A session attribute is a session-level storage container for data that can be
populated by an event. Tealeaf supports the use of up to 64 session attributes.
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From pre-Release 8.0 versions of Tealeaf, the LoginID and UserDef 1-4
user-defined values have been migrated to Session Attribute 0 and Session
Attributes 1-4, respectively.

See "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager Manual.

Note: Depending on the trigger of its populating event, a session attribute may
not be available in a search template, even if you configure it. For example, if
the session attribute is populated by an event triggered by End of Session, it is
possible to add the session attribute as a field to an Active search template, even
though the field is not yet populated for active sessions.

To add a session attribute to a search template:

1.

7.

Create the session attribute, including populating it with values generated by
an event. See "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager
Manual.

In the Search Templates page, select the template in which to create the session
attribute search field.

Click Search Fields. The Configured Search Fields dialog appears.
Select the Target Group from the drop-down.

* If your search template does not include an appropriate group, close the
Configured Search Fields dialog and click Add Group. See “Template Search
Fields” on page 76.

Before a search field is available for use in search templates, you must create it.
Click the + icon.

a. The Configure Search Field dialog appears.

b. Specify a title for the field, which appears in the search template and in the
search configuration page.

c. From the Keyword drop-down, select Session Attribute.

d. The Attribute selector is displayed in the Configure Search Field dialog.
Click <Select an attribute.

e. Select the session attribute in the displayed list. Click Select.
f. Configure the other properties as needed.
g. Click Save.

The selected session attribute is added to the search template under the
selected group.

To save changes to the server, click Save.

You may also add the session attribute as a column in the session list template. See
“Populating a session list template column with a session attribute” on page 93.

Adding Client User Interface Fields

Tealeaf Ul Capture enables the capture of user interface events that occur in the
visitor's browser. When deployed as part of your web application, UI Capture
tracks user interface events on the client and submits XML-based requests to the
web server, which enables those events to be captured and processed by Tealeaf.

Note: IBM Tealeaf CX UI Capture for AJAX requires the Extended Edition of the
IBM Tealeaf CX platform. please contact your IBM Tealeaf representative.

For more information on Ul Capture, see "Ul Capture FAQ" in the IBM Tealeaf Ul
Capture for AJAX FAQ.
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When UI Capture is deployed and configured for your web application, the
following values are inserted as variables in the [appdata] section of the request of
last viewable page before the UI event. These variables map to search keywords
that you can add to your search templates.

* These values are identified in the Windows pipeline and posted into the
[appdata] section by the Tealeaf Reference session agent. See "Tealeaf Reference
Session Agent" in the IBM Tealeaf CX Configuration Manual.

Table 5. Adding Client User Interface Fields

Request Variable Corresponding Search Keyword Description

TLT_CUI_URL Client UI URL URL as reported from the client user
interface

TLT_CUI_APPLICATION_NAME |[Client UI Application Name of the application as reported from
the client user interface.

The above values may differ from the standard reference values that are inserted
into the request by the Tealeaf Reference session agent, as the client user interface
may contain an entire application with unique URLs within a single HTML page.

Session List Templates

Session list templates are used to configure the appearance and the data of the list
of sessions returned from a search. The session list templates allow control of the
displayed fields of session data, how they should be treated, and other information
such as the server metrics.

Search templates can be set to use specific session list templates, or a template can
be selected at the time of the search. Much like the search templates, session list
templates have a set of properties, but they can also reference session list columns,
which are assigned to the templates.

| Seach Templates Seszion List Templates |

Templates Template Columns

Standard Template

Sessigh Time
Duration
Lagin ID
Events

Hits

o o L oo 1 v R v J|[ o mE &

Figure 13. Session List Templates
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* To create a new session list template, click Create. See “Configuring a Session
List Template.”

* To edit an existing session list template, select it and click Edit. See “Configuring
a Session List Template.”

* To copy a session list template, select it and click Copy. See “Copying a Session
List Template” on page 89.

* To assign the session list template to one or more search templates, select it and
click Assignments. See “Assigning a Session List Template” on page 90.

* To delete a session list template, select it and click Delete.

Configuring a Session List Template

Template Properties

Maximur Matches:

¥ Total Matches

M Replay Sessions

M QuickWiew

Title: IStandard Template
Type: In:::-:Irnpau:t ;l
Default Event Label: MobileApp

100

W Pages List Drilldown W Analyze Session Segment

W =Session Info Popup

W Download all Sessions

M Session zegrments Button

V¥ Server Metrics Table

W Display Search Query

Figure 14. Template Properties Session list templates have the following properties:

Property
Description
Title The name of the template.

Type

The type of search template:

cxImpact - standard search template. Use this one in almost all cases.

cxReveal - IBM Tealeaf cxReveal search templates can be used to specify
searches by session attribute of the IBM Tealeaf cxReveal database.

Note: The ability to search by session attribute requires IBM Tealeaf
cxReveal, an installation of the IBM Tealeaf cxReveal database, and
additional configuration. See "Configuring Session Attribute Search” in
the IBM Tealeaf cxReveal Administration Manual.

Default Event Label
Select the event label whose events should be displayed by default in the
QuickView page.
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¢ Users may select a different event label as needed in the QuickView
page.
* See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Maximum Matches
The maximum number of sessions to return from a search. This setting has
no effect on how many sessions are found or examined; it only determines
the number of sessions available to the user. For performance reasons, you
cannot set this value above 10000.

* This setting should be configured in conjunction with other search limit
settings. See “Configuring Maximum Session Display Limits” on page
89.

Total Matches
Displays the total number of matching sessions.

Replay Sessions
Enables the replay of sessions from the session list.

Pages List Drilldown
Allows examining the pages of a returned session within the Portal.

QuickView
Enable the user to open the QuickView page, where the events that fired
on each page can be reviewed.

¢ See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Session Info Popup
Allows the user to get a quick list of session attributes from the session list.

Download Al11 Sessions
Displays the Download All button, which allows users with RTV installed
to open all sessions found in a search.

Session Segments Button
Displays the Manage Segments button in the session list, which allows
users to access the Manage Segments page.

Note: When this button is enabled in session list templates accessible to
IBM Tealeaf cxReveal users, it is not displayed in the session list because
IBM Tealeaf cxReveal users cannot create session segments. IBM Tealeaf
cxReveal administrators may be able to create session segments through
the Manage Session Segments page.

See "Managing Session Segments" in the IBM Tealeaf cxResults User Manual.

Analyze Session Segment
Displays the Analyze Segment button, which can be click to analyze the
session segment of a search directly from the Session List. See "Analyzing
Session Segments" in the IBM Tealeaf cxResults User Manual.

Note: When this button is enabled in session list templates accessible to

IBM Tealeaf cxReveal users, it is not displayed in the session list because
IBM Tealeaf cxReveal users cannot create session segments. IBM Tealeaf

cxReveal administrators may be able to create session segments through

the Manage Session Segments page. See "Managing Session Segments" in
the IBM Tealeaf cxResults User Manual.

Server Metrics Table
Displays the table listing the servers that were searched with elapsed time
and number of returned sessions.
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Display Search Query
Allows the query used in the search to appear on the Search Results page.

Configuring Maximum Session Display Limits:

When configuring the number of sessions that are displayed in search results,
several Portal settings may affect the result.

* Search Database Max Sessions Returned - (IBM Tealeaf cxReveal database
searches only) This parameter defines the maximum number of sessions that can
be returned from a search of the IBM Tealeaf cxReveal database. For IBM Tealeaf
cxReveal database searches, other session display limits may be applied to
further limit the number of sessions displayed; the number of displayed search
results never exceeds this number of database searches.

— See "cxReveal Settings" in the IBM Tealeaf cxReveal Administration Manual.

* Maximum Matches - In the specified session list template, you can configure the
maximum number of sessions that can possibly be displayed in the template.

— Regardless of the values of other settings, the Maximum Matches setting defines
the limit to be displayed in a session list.
— For performance reasons, this value cannot exceed 10000.

* Session Segment Max Sessions Limit - In the Portal Management page, you can
specify the maximum number of sessions that any newly generated segment can
contain.

— See "CX Settings" in the IBM Tealeaf cxImpact Administration Manual.
— See "cxReveal Settings" in the IBM Tealeaf cxReveal Administration Manual.

* Live Max Results Limit or Completed Max Results Limit - In the Portal
Management page, these settings determine the number of sessions that can be
displayed for any active or complete session search, regardless of the template
setting.

— See "CX Settings" in the IBM Tealeaf cxImpact Administration Manual.
— See "cxReveal Settings" in the IBM Tealeaf cxReveal Administration Manual.

* Auto Stop Limit - This setting defines the number of sessions that Search Server
inspects per Canister before returning results. From an individual Canister,

Search Server does not inspect more sessions for matches than the number
configured for this setting. By default, this value is set to 10000.

— See "Configuring the Search Server" in the IBM Tealeaf CX Configuration
Manual.

The maximum number of sessions displayed in a search result is the minimum of
the applicable settings. The Live or Completed limit is applicable depending on the
type of search and only in cases where the search generates a new result set.

* Results can be returned into existing result sets, where the maximum limits for
the existing result are applied, instead of the current Portal settings.

Limits for searches executed from IBM Tealeaf CX RealiTea Viewer can be
configured in the RTV Search setup dialog. See "RTV Search Setup" in the IBM
Tealeaf RealiTea Viewer User Manual.

Copying a Session List Template
To copy a template, select it from the list of templates and click the Copy button
beneath the list.
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The Duplicate Columns option controls whether or not copies are also made of the
columns associated with the template. Because columns and templates are
independent, multiple templates can use the same column.

* If the Duplicate Columns option is selected, new copies of the columns are
created along with the new template. Otherwise, the new template uses the
same columns as the original.

Assigning a Session List Template

To assign a session list template to one or more search templates, select one or
more search templates and click the Assignments button beneath the list of
templates. The selected search templates are updated to use the current session list
template by default.

Selecting a Session List Template
In the Search page, you can select a session list template to use.

* See "Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

* If IBM Tealeaf cxResults is licensed, you can select session list templates in the
Visitor Search page. See "Searching for Visitors" in the IBM Tealeaf cxResults User
Manual.

For completed session searches, you can choose to display them in a different
session list template. See "Managing Session Segments" in the IBM Tealeaf cxResults
User Manual.

Example Session List Templates
This section explains the use of session list templates to filter your search results.

Session counts template:

In some cases, you may only be interested in the number of instances that the
search criteria occurred. You can configure a session list template to return only the
counts of found results.

* When searching for session counts only, the display of the results is faster; the
search itself takes the same length of time.

* Even if you are only returning the session counts in the session list, the list of
returned sessions can still be exported through the Portal.

To configure:

Click the Session List Templates tab.

Create or select the session list template to use.

For the Maximum Matches value, enter 0.

Select the Total Matches checkbox.

Select the Server Metrics Table checkbox.

The other checkboxes are irrelevant to this template.
Click Save.

* To make this the default session list template for users or groups, you must
assign the session list template. See “Assigning a Session List Template.”

N oo~ =

Session List Columns

Session list columns are used on session list templates, and they control what is
displayed in the list of matching sessions. The columns can be used to display
session attributes, compare session attributes to specified values, or flag for the
existence of specific events or other attributes.
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* For more information on the columns in the standard session list template, see
"Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

Adding a Session List Column to a Template

Select a Session List template, and the template's columns are listed in the
Template Search Columns pane. To select configured columns, click the All
Columns button. To add a column to the template, select a column and click the
Add To Template button. Columns in the Session List Columns pane can be
reordered using drag and drop.

Configuring a Session List Column

On the Search Template Configuration page, the All Columns button in the
Template Search Columns pane displays a popup of the currently available
columns. Use the New button to start creating a new column, or select an existing
column and use the Edit button.

Configure Session List Column

Title:
Type:
Field:

Compare
Yalue:

Canister Mame

cxlmpact

Canister Mame

alignment:

< Default>

Qperation:

Equals Cormpare Walue

il =

Canisterol

| e

Figure 15. Configure Session List Column

For more information on configuring an event column, see “Configuring an Event
Column in a Session List Template” on page 92.

Session list template columns have the following properties:

Property
Description

Title The title of the column, displayed on the session list.

Type The type of session list template column:
* cxImpact - standard search template column. Use this one in almost all
cases.

* cxReveal - IBM Tealeaf cxReveal search templates can be used to specify
searches by session attribute of the IBM Tealeaf cxReveal database.

Note: The ability to search by session attribute requires IBM Tealeaf
cxReveal, an installation of the IBM Tealeaf cxReveal database, and
additional configuration. See "Configuring Session Attribute Search” in
the IBM Tealeaf cxReveal Administration Manual.
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Field The session field that the column uses for data.

Note: The list of available fields depends on whether standard or extended
indexing is in use. For more information on indexed fields, see "RealiTea
Viewer - What is Indexed and Searchable" in the IBM Tealeaf RealiTea Viewer
User Manual.

Alignment
Optionally, you can override the default alignment setting for the specific
value type to be applied to the session list column by making a selection in
the drop-down.

Operation
How the data is displayed or used:

* <Display Field Value> - The field's value is displayed directly.

* Equals Compare Value - A checkmark is displayed if the value of the
Field exactly matches the Compare Value.

* Less Than Compare Value - For numeric fields, a checkmark is
displayed if the value of the Field is less than the Compare Value.

* Greater Than Compare Value - For numeric fields, a checkmark is
displayed if the value of the Field is greater than the Compare Value.

Compare Value
The value against which to compare the Field value.

Events To List
The set of possible events to list for the Event List Subset field. The listed
events are the intersection of the events of each session and the supplied
list for the column. To add or remove events, click the Add or Remove
buttons above the list.

Configuring an Event Column in a Session List Template:

You can configure the event icons displayed in a session list column. When an
event list subset column is added to a session list template, you can provide
parameters on the events for which you can search.

* In the session list, users can review details on the event. See "Searching Session
Data" in the IBM Tealeaf cxImpact User Manual.

1. In the Session List Templates tab, select the template to edit or create a new
one.

2. Select the event column to edit, or create a new one.
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Configure Session List Column

Title: Event List

Field: Event List Subset

=]
Alignment: | Left ;I
Events To List: =

Unknown Event
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Figure 16. Configure Session List Column

3. From the Field drop-down, select Event List Subset.

4. Use the + and - buttons to add or remove events from the list.
5. Save the column.

6. Add the column to the template, if necessary.

7. Save the template.

Populating a session list template column with a session attribute:

Tealeaf enables the creation and tracking of up to 64 session-level parameters into
distinct session attributes. If desired, you can populate session list templates with
session attributes, which is useful for exporting session data.

Note: Columns populated by session attributes are sorted as text values.

¢ For more information on session attributes, see "TEM Session Attributes Tab" in
the IBM Tealeaf Event Manager Manual.

To add a session attribute to a session list template:

1. Create the session attribute, including populating it with values generated by
an event. See "TEM Session Attributes Tab" in the IBM Tealeaf Event Manager
Manual.

2. In the Search Templates page, select the session list template in which to create
the session attribute search field.

3. Click All Columns. The Configured Session List Columns dialog appears.

4. Before a session list column is available for use in search templates, you must
create it. Click the + icon.
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a. The Configure Session List Column dialog appears.

b. Specify a title for the column, which appears in the session list and its
template.

c. From the Field drop-down, select Session Attribute Value.

d. The Attribute selector is displayed in the Configure Search Column dialog.
Click <Select an attribute.

e. Select the session attribute in the displayed list. Click Select.
f. Select the desired Operation from the drop-down.

* To export the values of the session attribute, select <Display Field
Value>.

g. Click Save.
5. The selected session attribute is added to the list of available columns.
6. To add the new column to your template, select it and click Add to Template.
7. To save changes to the server, click Save.

* For more information on exporting data through the session list template, see
"Searching Session Data" in the IBM Tealeaf cxImpact User Manual.

You may also add session attributes as fields to your search template. See “Adding
Session Attributes” on page 84.

Building Searches via Encoded URL

This section describes how you can build an encoded URL to execute a specified
search.

Note: The best method for building searches via encoded URL is to create and
execute the search through the Tealeaf Portal. When the desired results are
displayed, you may step back to the search page and click the Link to Search
button in the search toolbar to display the URL that creates the search. Users who
execute this search via URL may still be required to authenticate through the
Tealeaf Portal. See "Searching Session Data" in the IBM Tealeaf cxImpact User
Manual.

Overview
All parameters must be URL-encoded.

Required Arguments: template

Argument
Value

template
The ID of the template to be loaded. The user must have permission to
view this template. The IDs for templates can be found on the search
template config page with the Edit button for templates.

fieldX Either the active search keyword or the archive search keyword (e.g.
request) for a search field. The first matching search field will be selected
from the template and used. Knowledge of acceptable keywords is
required, so we have to provide a master list somewhere.

opX The operator value for the field
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valueAX
The first value to populate the field with. Text inputs only use valueA -
others such as form fields, or numerical fields with the between operator
can use valueB

valueBX
The second value to populate the field with

For field, op, valueA and valueB, the X is a numerical index starting at 0. For
example, fieldO=request, op0=1, valueAO=tealeaf will find a search field in the
template that uses the request keyword, set the operator to includes, and
populate it with the text tealeaf.

Required Arguments: template

Argument
Value

datespan
The numeric constant representing the dates to search on.

startdate
If datespan is set to -1, this is the ISO-format date for the beginning date of
the range (e.g. 2007-01-02 is Jan 02, 2007)

enddate
If datespan is set to -1, this is the ISO-format date for the end date of the
range (e.g. 2007-01-02 is Jan 02, 2007)

starttime
If datespan is set to -1, this is the 6-digit, 24-hour time for the beginning of
the range, in HHMMss format (e.g. 003015 is 00:30:15 or 12:30:15 AM)

endtime
If datespan is set to -1, this is the 6-digit, 24-hour time for the end of the
range, in HHMMSss format (e.g. 233059 is 23:30:59 or 11:30:59 PM)

scope The scope of the search.
sort  How the results will be sorted

timeout
The maximum allotted time for an archive search, in seconds. The search
will be stopped once this amount of time has elapsed, but more time may
be required to collate the sessions found.

autostop
Specifies the limit at which an archive search will be stopped. When X
matching sessions are found, the search is stopped.

dosearch
If set to 1, the search will be performed once all the fields have been
processed and populated. This mode takes you to the search builder, so the
search results will appear as a second breadcrumb. This allows a search to
be performed, but the user will still be able to go back and tweak the
constraints to refine the search.

Operator Values

The following values may be included in the opX parameter:

Value Description
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1 Includes/contains (active/archive)
-1 NOT includes/contains

2 Equal (numerical)

-2 NOT equal

3 Between (numerical)

-3 NOT between

4 Greater than

5 Less than
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Chapter 7. cxReveal database

The IBM Tealeaf cxReveal (TL_SEARCH) database stores session attribute data and
other session-related data in the database as soon as it is captured. This immediate
capture allows rapid access to sessions for IBM Tealeaf cxReveal users and fast
response times when querying through the Portal for sessions.

In the database, data is stored in individual tables for each day.

The IBM Tealeaf cxReveal database requires the following:
* IBM Tealeaf cxReveal license
* IBM Tealeaf cxConnect for Data Analysis license (for Event Bus)

Filegroups

* PRIMARY - The default filegroup for the database. Used by SQL Server for
record keeping and management in the database.

* LOOKUP - Contains all non-search Tealeaf data.

* INDEX - Contains the non-clustered indexes for the data in the LOOKUP
filegroup.

* SESSION - Contains the searchable session data.

* SESSION_INDEX - The non-clustered indexes on the searchable data.

Sizing

The size of the database correlates directly to the number of sessions per day that
are processed by Tealeaf. For each session, one row is created and stored while the
session is retained in the source Canister.

* For most customers, this database should range from 50 GB to 300 GB.

Reports

Tealeaf captures statistical information from this database, which is available
through the Portal.

¢ See "System Status" in the IBM Tealeaf cxImpact Administration Manual.
* See "System Status" in the IBM Tealeaf cxImpact Administration Manual.
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Chapter 8. IBM Tealeaf documentation and help

IBM Tealeaf provides documentation and help for users, developers, and

administrators.

Viewing product documentation

All IBM Tealeaf product documentation is available at the following website:

https:/ /tealeaf.support.ibmcloud.com/

Use the information in the following table to view the product documentation for

IBM Tealeaf:
Table 6. Getting help

To view...

Do this...

Product documentation

On the IBM Tealeaf portal, go to ? > Product
Documentation.

Help for a page on the IBM Tealeaf Portal

On the IBM Tealeaf portal, go to ? > Help
for This Page.

Available documents for IBM Tealeaf products

Use the following table to view a list of available documents for all IBM Tealeaf

products:

Table 7. Available documentation for IBM Tealeaf products

IBM Tealeaf products

Available documents

IBM Tealeaf CX

* IBM Tealeaf Customer Experience Overview
Guide

* IBM Tealeaf CX Client Framework Data
Integration Guide

* IBM Tealeaf CX Configuration Manual
* IBM Tealeaf CX Cookie Injector Manual
* IBM Tealeaf CX Databases Guide

* IBM Tealeaf CX Event Manager Manual
* IBM Tealeaf CX Glossary

* IBM Tealeaf CX Installation Manual

* IBM Tealeaf CX PCA Manual

* IBM Tealeaf CX PCA Release Notes
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Table 7. Available documentation for IBM Tealeaf products (continued)

IBM Tealeaf products

Available documents

IBM Tealeaf CX

* IBM Tealeaf CX RealiTea Viewer Client Side
Capture Manual

* IBM Tealeaf CX RealiTea Viewer User
Manual

* IBM Tealeaf CX Release Notes
* IBM Tealeaf CX Release Upgrade Manual

* IBM Tealeaf CX Support Troubleshooting
FAQ

* IBM Tealeaf CX Troubleshooting Guide
* IBM Tealeaf CX UI Capture j2 Guide
* IBM Tealeaf CX UI Capture j2 Release Notes

IBM Tealeaf cxImpact

* IBM Tealeaf cxImpact Administration Manual
* IBM Tealeaf cxImpact User Manual
* IBM Tealeaf cxImpact Reporting Guide

IBM Tealeaf cxConnect

* IBM Tealeaf cxConnect for Data Analysis
Administration Manual

* IBM Tealeaf cxConnect for Voice of Customer
Administration Manual

* IBM Tealeaf cxConnect for Web Analytics
Administration Manual

IBM Tealeaf cxOverstat

IBM Tealeaf cxOuverstat User Manual

IBM Tealeaf cxReveal

* IBM Tealeaf cxReveal Administration Manual
* IBM Tealeaf cxReveal API Guide
* IBM Tealeaf cxReveal User Manual

IBM Tealeaf cxVerify

IBM Tealeaf cxVerify Administration Manual

IBM Tealeaf cxView

IBM Tealeaf cxView User Manual

IBM Tealeaf CX Mobile

* IBM Tealeaf CX Mobile Android Logging
Framework Guide

* IBM Tealeaf Android Logging Framework
Release Notes

* IBM Tealeaf CX Mobile Administration
Manual

* IBM Tealeaf CX Mobile User Manual

* IBM Tealeaf CX Mobile iOS Logging
Framework Guide

* IBM Tealeaf iOS Logging Framework Release
Notes
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Bay Area Lab

1001 E Hillsdale Boulevard
Foster City, California 94404
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
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programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy Considerations

IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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